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Garantie 2
Tektronix garantiert, dass dieses Produkt für einen Zeitraum von einem (1) Jahr ab Versanddatum keine Fehler in Material und
Verarbeitung aufweist. Wenn ein Produkt innerhalb dieser Garantiezeit Fehler aufweist, steht es Tektronix frei, dieses fehlerhafte
Produkt kostenlos zu reparieren oder einen Ersatz für dieses fehlerhafte Produkt zur Verfügung zu stellen. Von Tektronix für
Garantiezwecke verwendete Teile, Module und Ersatzprodukte können neu oder in ihrer Leistung neuwertig sein. Alle ersetzten
Teile, Module und Produkte werden Eigentum von Tektronix.

Um mit dieser Garantie Kundendienst zu erhalten, muss der Kunde Tektronix über den Fehler vor Ablauf der Garantiezeit informieren
und geeignete Vorkehrungen für die Durchführung des Kundendienstes treffen. Der Kunde ist für die Verpackung und den Versand
des fehlerhaften Produkts an die Service-Stelle von Tektronix verantwortlich, die Versandgebühren müssen im Voraus bezahlt sein.
Tektronix übernimmt die Kosten der Rücksendung des Produkts an den Kunden, wenn sich die Versandadresse innerhalb des Landes
der Tektronix Service-Stelle befindet. Der Kunde übernimmt alle Versandkosten, Fracht- und Zollgebühren sowie sonstige Kosten
für die Rücksendung des Produkts an eine andere Adresse.

Diese Garantie tritt nicht in Kraft, wenn Fehler, Versagen oder Schaden auf die falsche Verwendung oder unsachgemäße und falsche
Wartung oder Pflege zurückzuführen sind. Tektronix muss keinen Kundendienst leisten, wenn a) ein Schaden behoben werden
soll, der durch die Installation, Reparatur oder Wartung des Produkts von anderem Personal als Tektronix-Vertretern verursacht
wurde; b) ein Schaden behoben werden soll, der auf die unsachgemäße Verwendung oder den Anschluss an inkompatible Geräte
zurückzuführen ist; c) Schäden oder Fehler behoben werden sollen, die auf die Verwendung von Komponenten zurückzuführen sind,
die nicht von Tektronix stammen; oder d) wenn ein Produkt gewartet werden soll, an dem Änderungen vorgenommen wurden oder
das in andere Produkte integriert wurde, so dass dadurch die aufzuwendende Zeit für den Kundendienst oder die Schwierigkeit der
Produktwartung erhöht wird.

DIESE GARANTIE WIRD VON TEKTRONIX FÜR DAS PRODUKT ANSTELLE ANDERER AUSDRÜCKLICHER ODER IMPLIZITER
GARANTIEN GEGEBEN. TEKTRONIX UND SEINE HÄNDLER SCHLIESSEN AUSDRÜCKLICH ALLE GARANTIEN HINSICHTLICH
DER HANDELSGÄNGIGKEIT UND DER EIGNUNG FÜR EINEN BESTIMMTEN ZWECK AUS. FÜR TEKTRONIX BESTEHT DIE
EINZIGE UND AUSSCHLIESSLICHE VERPFLICHTUNG DIESER GARANTIE DARIN, FEHLERHAFTE PRODUKTE FÜR DEN
KUNDEN ZU REPARIEREN ODER ZU ERSETZEN. TEKTRONIX UND SEINE HÄNDLER ÜBERNEHMEN KEINERLEI HAFTUNG
FÜR DIREKTE, INDIREKTE, BESONDERE UND FOLGESCHÄDEN, UNABHÄNGIG DAVON, OB TEKTRONIX ODER DER
HÄNDLER VON DER MÖGLICHKEIT SOLCHER SCHÄDEN IM VORAUS UNTERRICHTET IST.
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Allgemeine Sicherheitshinweise

Allgemeine Sicherheitshinweise
Beachten Sie zum Schutz vor Verletzungen und zur Verhinderung von Schäden an diesem Gerät oder an damit verbundenen
Geräten die folgenden Sicherheitshinweise.

Verwenden Sie dieses Gerät nur gemäß der Spezifikation, um jede mögliche Gefährdung auszuschließen.

Wartungsarbeiten sind nur von qualifiziertem Personal durchzuführen.

Während der Verwendung des Geräts müssen Sie eventuell auf andere Teile eines umfassenderen Systems zugreifen.
Beachten Sie die Sicherheitsangaben in Handbüchern für andere Komponenten bezüglich Warn- und Vorsichtshinweisen
zum Betrieb des Systems.

Verhütung von Bränden und Verletzungen
Verwenden Sie ein ordnungsgemäßes Netzkabel. Verwenden Sie nur das mit diesem Produkt ausgelieferte und
für das Einsatzland zugelassene Netzkabel.

Schließen Sie das Gerät ordnungsgemäß an. Trennen oder schließen Sie keine Tastköpfe oder Prüfleitungen
an, während diese an einer Spannungsquelle anliegen.

Erden Sie das Produkt. Das Gerät ist über den Netzkabelschutzleiter geerdet. Zur Verhinderung von Stromschlägen
muss der Schutzleiter mit der Stromnetzerdung verbunden sein. Vergewissern Sie sich, dass eine geeignete Erdung besteht,
bevor Sie Verbindungen zu den Eingangs- oder Ausgangsanschlüssen des Geräts herstellen.

Beachten Sie alle Angaben zu den Anschlüssen. Beachten Sie zur Verhütung von Bränden oder Stromschlägen
die Kenndatenangaben und Kennzeichnungen am Gerät. Lesen Sie die entsprechenden Angaben im Gerätehandbuch,
bevor Sie das Gerät anschließen.

Die Eingänge sind nicht für Anschlüsse an Hauptstromkreise oder Schaltkreise der Kategorien II, III und IV ausgelegt.

Schließen Sie den Tastkopf-Referenzleiter nur an die Erdung an.

Trennen vom Stromnetz. Das Netzkabel trennt das Gerät von der Stromversorgung. Blockieren Sie das Netzkabel nicht,
da es für die Benutzer jederzeit zugänglich sein muss.

Schließen Sie die Abdeckungen. Nehmen Sie das Gerät nicht in Betrieb, wenn Abdeckungen oder Gehäuseteile
entfernt sind.

Bei Verdacht auf Funktionsfehler nicht betreiben. Wenn Sie vermuten, dass das Gerät beschädigt ist, lassen
Sie es von qualifiziertem Wartungspersonal überprüfen.

Vermeiden Sie offen liegende Kabel. Berühren Sie keine freiliegenden Anschlüsse oder Bauteile, wenn diese unter
Spannung stehen.

Nicht bei hoher Feuchtigkeit oder Nässe betreiben.

Nicht in Arbeitsumgebung mit Explosionsgefahr betreiben.

Sorgen Sie für saubere und trockene Produktoberflächen.
Sorgen Sie für die richtige Kühlung. Weitere Informationen über die Gewährleistung einer ordnungsgemäßen Kühlung
für das Produkt erhalten Sie im Handbuch.
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Begriffe in diesem Handbuch
In diesem Handbuch werden die folgenden Begriffe verwendet:

WARNUNG. Warnungen weisen auf Bedingungen oder Verfahrensweisen hin, die eine Verletzungs- oder Lebensgefahr
darstellen.

VORSICHT. Vorsichtshinweise machen auf Bedingungen oder Verfahrensweisen aufmerksam, die zu Schäden am Gerät
oder zu sonstigen Sachschäden führen können.

Symbole und Begriffe am Gerät
Am Gerät sind eventuell die folgenden Begriffe zu sehen:

GEFAHR weist auf eine Verletzungsgefahr hin, die mit der entsprechenden Hinweisstelle unmittelbar in Verbindung steht.

WARNUNG weist auf eine Verletzungsgefahr hin, die nicht unmittelbar mit der entsprechenden Hinweisstelle in
Verbindung steht.

VORSICHT weist auf mögliche Sach- oder Geräteschäden hin.

Am Gerät sind eventuell die folgenden Symbole zu sehen:
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Umweltschutzhinweise
In diesem Abschnitt finden Sie Informationen zu den Auswirkungen des Produkts auf die Umwelt.

Vorgehen bei Produktauslauf
Beachten Sie beim Recycling eines Geräts oder einer Komponente die folgenden Richtlinien:

Geräterecycling. Zur Herstellung dieses Geräts werden natürliche Ressourcen verwendet. Das Gerät kann Substanzen
enthalten, die bei unsachgemäßer Entsorgung nach Produktauslauf Umwelt- und Gesundheitsschäden hervorrufen können.
Um eine solche Umweltbelastung zu vermeiden und den Verbrauch natürlicher Ressourcen zu verringern, empfehlen
wir Ihnen, dieses Produkt über ein geeignetes Recyclingsystem zu entsorgen und so die Wiederverwendung bzw. das
sachgemäße Recycling eines Großteils des Materials zu gewährleisten.

Dieses Symbol kennzeichnet Produkte, die den Bestimmungen der Europäischen Union gemäß Richtlinie
2002/96/EG über Elektro- und Elektronik-Altgeräte entsprechen. Informationen zu Recyclingmöglichkeiten
finden Sie im Abschnitt zu Support und Service auf der Tektronix-Website (www.tektronix.de).

Sicherheitshinweis zu quecksilberhaltigen Komponenten. Dieses Produkt ist mit einer quecksilberhaltigen
LCD-Beleuchtung ausgestattet. Aufgrund von Umweltschutzbestimmungen ist die Entsorgung daher möglicherweise
reglementiert. Einzelheiten zu den Entsorgungs- bzw. Recyclingbestimmungen erhalten Sie bei den zuständigen Behörden
vor Ort oder innerhalb der Vereinigten Staaten von Electronics Industries Alliance (www.eiae.org).

Materialien mit Perchlorat. Dieses Produkt enthält eine oder mehrere Arten von CR Lithium-Knopfzellenbatterien. Im
US-Bundesstaat Kalifornien werden CR Lithium-Knopfzellenbatterien als Perchlorat enthaltende Materialien eingestuft und
erfordern besondere Behandlung. Weitere Informationen finden Sie unter www.dtsc.ca.gov/hazardouswaste/perchlorate
(auf Englisch).

Beschränkung von Gefahrenstoffen
Dieses Produkt wurde als Überwachungs- und Steuerungsgerät klassifiziert und unterliegt daher nicht dem Geltungsbereich
der Richtlinie 2002/95/EG RoHS.
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Vorwort
In diesem Handbuch werden die Installation und der Betrieb der Geräte der Serien DPO7000, DSA70000 und DPO70000
beschrieben. In diesem Handbuch wird die grundlegende Bedienung und Funktionsweise dargelegt. Detailliertere
Informationen finden Sie in der Online-Hilfe zu Ihrem Gerät. Dieses Handbuch bezieht sich auf folgende Geräte:

DPO72004 und DSA72004

DPO71604 und DSA71604

DPO71254 und DSA71254

DPO70804 und DSA70804

DPO70604 und DSA70604

DPO70404 und DSA70404

DPO7354

DPO7254

DPO7104

DPO7054

Wichtige Leistungsmerkmale
Mithilfe von Geräten der Serien DPO7000, DSA70000 und DPO70000 können Sie elektronische Schaltungen überprüfen,
testen und charakterisieren. Sie zeichnen sich durch die folgenden Leistungsmerkmale aus:

20 GHz Bandbreite und 50 GS/s Echtzeit-Abtastrate auf allen Kanälen, DPO72004 und DSA72004

16 GHz Bandbreite und 50 GS/s Echtzeit-Abtastrate auf allen Kanälen, DPO71604 und DSA71604

12,5 GHz Bandbreite und 50 GS/s Echtzeit-Abtastrate auf allen Kanälen, DPO71254 und DSA71254

8 GHz Bandbreite und 25 GS/s Echtzeit-Abtastrate auf allen Kanälen, DPO70804 und DSA70804

6 GHz Bandbreite und 25 GS/s Echtzeit-Abtastrate auf allen Kanälen, DPO70604 und DSA70604

4 GHz Bandbreite und 25 GS/s Echtzeit-Abtastrate auf allen Kanälen, DPO70404 und DSA70404

3,5 GHz Bandbreite und 10 GS/s Echtzeit-Abtastrate auf allen Kanälen, 40 GS/s auf einem Kanal, DPO7354

2,5 GHz Bandbreite und 10 GS/s Echtzeit-Abtastrate auf allen Kanälen, 40 GS/s auf 1 Kanal, DPO7254

1 GHz Bandbreite und 5 GS/s (10 GS/s optional) Echtzeit-Abtastrate auf allen Kanälen, 20 GS/s (40 GS/s optional) auf
1 Kanal, DPO7104

500 MHz Bandbreite und 2,5 GS/s (5 GS/s optional) Echtzeit-Abtastrate auf allen Kanälen, 10 GS/s (20 GS/s optional)
auf 1 Kanal, DPO7054

Funktion „Vergrößerte Bandbreite“, die im aktivierten Zustand DSP-Filter (Digital Signal Process) anwendet, die die
Bandbreite vergrößern und den Durchlassbereich abflachen können. Die Funktion „Vergrößerte Bandbreite“ ermöglicht
ein abgestimmtes Ansprechverhalten über alle aktivierten Kanäle hinweg, wenn diese die maximale Abtastrate erreichen.
Die Bandbreite kann zur Optimierung des Signal-Rausch-Verhältnisses in 1 GHz-Schritten abwärts bis auf 500 MHz
für die maximale Bandbreite begrenzt werden. Die vergrößerte Bandbreite wird bei einigen Hochleistungstastköpfen
und -tastkopfspitzen auf die Tastkopfspitze ausgedehnt.
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Vorwort

Je nach Modell und Option reicht die Länge der Signalaufzeichnung bis zu 400.000.000 Abtastpunkten.

Je nach Modell Genauigkeit der Gleichstrom-Vertikalverstärkung bis zu 1,0 %

Vier Eingangskanäle (jeweils mit 8-Bit-Auflösung, sofern nicht der Hi-Res-Modus eingestellt ist), zusätzlicher
Triggereingang und -ausgang

Erfassungsmodi Abtastwert, Hüllkurve, Spitzenwerterfassung, hohe Auflösung, Signaldatenbank, Mittelwert und
Schnellerfassung

Voll programmierbar, mit einer umfangreichen Menge von GPIB-Befehlen und einer nachrichtenbasierten Schnittstelle

Zu den Triggertypen gehören die Signalflanke, die Logik und der Impuls (können nach Logikstatus qualifiziert werden),
die für die Triggerereignisse A und B ausgewählt werden können. Der Fenster-Triggermodus triggert, wenn die
Triggerquelle an ein definiertes Fenster weitergeleitet wird oder dieses verlässt. Trigger können nach dem Logikstatus
qualifiziert werden. Der Setup- und Hold-Triggermodus triggert, wenn ein logischer Eingangswert seinen Zustand
innerhalb der Einstell- und Haltezeiten in bezug auf den Takt ändert. Je nach Modell beträgt der Triggerjitter weniger
als 1 ps eff (typisch). Normalerweise können Sie auf einem Glitch oder Impuls von weniger als 200 ps in der Breite
triggern. Bei einigen Modellen oder Optionen steht serielles Triggern von Low-Speed-Bussen, Triggern auf serielle
Muster und Triggern zum Sperren von Mustern zur Verfügung. Korrektur der auswählbaren Triggerposition zwecks
genauerer Triggerpositionierung und Jitterreduktion

Leistungsstarke integrierte Messfunktionen, u. a. Histogramme, automatische Messungen, Messungen von
Augendiagrammen und eine Messstatistik.

Kombinieren Sie die Signale mathematisch, um solche Signale zu erstellen, die Ihre Datenanalyseaufgabe unterstützen.
Verwenden Sie in den mathematischen Gleichungen Arbiträrfilter. Nutzen Sie für die Signalanalyse im Frequenzbereich
die Spektralanalyse.

Sie können die Abtastdichte auf einem hochauflösenden XGA-Farbmonitor (307,3 mm, 12,1 Zoll), der die
Farbabstimmung der Signaldaten unterstützt, anzeigen. 10 Skalenteile können sowohl horizontal als auch vertikal
angezeigt werden.

Mit MultiView Zoom können Sie bis zu vier Zoombereiche gleichzeitig anzeigen und miteinander vergleichen. Bis zu vier
Zoombereiche können gesperrt werden, und Sie können in bis zu vier Zoombereichen manuell oder automatisch einen
Bildlauf durchführen. Im Zoomfenster kann die Sichtbarkeit der Signale gesteuert werden.

Automatische Ereignissuche und Benutzermarkierungen, damit Sie die gewünschten interessanten Erscheinungen auf
Ihren Signalen suchen und darauf verweisen können.

Automatische DDR-Analyse mithilfe der Option DDR-Speichertechnologieanalyse

Konfigurierbare MyScope-Steuerungsfenster

Möglichkeit zum Steuern von Abtastrate und Aufzeichnungslänge getrennt von der Zeit pro Skalenteil.

Intuitive grafische Benutzeroberfläche (UI) mit integrierter Online-Hilfe, die auf dem Bildschirm angezeigt werden kann

Interner entnehmbarer Festplattenspeicher

Große Vielfalt an Tastkopfmesslösungen

Schnellstart-Benutzerhandbuch für die DPO7000-Serie und die DPO/DSA70000-Serie ix



Vorwort

Dokumentation
Nachfolgend erhalten Sie einen Überblick, in welchen Teilen der Dokumentation bestimmte Typen von Informationen
zu diesem Produkt zu finden sind.

Thema Dokumente
Installation und Betrieb (Überblick) Schnellstart-Benutzerhandbuch. Enthält allgemeine Hinweise zur

Bedienung.
Ausführliche Hilfe zur Bedienung und zur
Benutzeroberfläche

Online-Hilfe. Bietet ausführliche Anweisungen für die Benutzung der
Gerätefunktionen. Um Informationen über Steuerelemente und Elemente
auf dem Bildschirm zu erhalten, greifen Sie über die Taste Help (Hilfe)
oder über das Menü Help (Hilfe) auf die Online-Hilfe zu. (Siehe Seite 18,
Zugriff auf die Online-Hilfe.)

Programmierbefehle Programmieranleitung (auf der Produktsoftware-CD). Enthält die Syntax
der GPIB-Befehle.

Analyse- und Anschlusstools Handbuch „Erste Schritte mit OpenChoice-Lösungen“ Bietet Informationen
zu verschiedenen auf dem Gerät vorhandenen Anschluss- und
Analysetools.

In diesem Handbuch verwendete Konventionen
Die folgenden Symbole werden in diesem Handbuch verwendet.

Verfahrenss-
chritt

Netzschalter
auf der
Frontplatte

Netzan-
schluss

Netzwerk PS2 SVGA USB
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Installieren des Geräts

Installieren des Geräts
Packen Sie das Gerät aus und überprüfen Sie, ob Sie alle als Standardzubehör angegebenen Teile erhalten haben. In der
Online-Hilfe sind empfohlene Zubehörteile, Tastköpfe, Geräteoptionen und Aktualisierungen aufgeführt. Die aktuellsten
Informationen finden Sie auf der Website von Tektronix (www.tektronix.com).

Standardzubehör

Zubehör Tektronix-Teilenummer
Schnellstart-Benutzerhandbuch für die Digitalen Phosphor-Oszilloskope
DPO7000, DSA70000 und DPO70000

071-1733-xx

Produktsoftware-CD zu DPO7000, DSA70000 und DPO70000 020-2693-xx
CD mit optionaler Anwendungssoftware und Dokumentationssatz 020-2700-xx
Online-Hilfe (Bestandteil der Produktsoftware) —
Leistungsprüfung (eine PDF-Datei auf der Produktsoftware-CD) —
Online-Programmieranleitung (Dateien auf der Produktsoftware-CD) —
NIST, Z540-1 und das ISO9000-Kalibrierungszertifikat —
Vier passive 10X-Tastköpfe, 500 MHz-Modelle, nur bei DPO7054 P6139A
Ein TekConnect-Adapter, nur für Modelle ≥ 4 GHz TCA-BNC
Vier TekConnect-Adapter, nur für Modelle ≥4 GHz TCA-292MM
Tastatur, nur für Modelle ≥4 GHz 119-7083-xx
Optische Maus 119-7054-xx
Frontschutzdeckel 200-4963-xx
Zubehörbeutel Modelle mit <4 GHz: 016-1966-xx

Modelle mit ≥4 GHz: 016-1441-xx
Tastkopfkalibrierung und Deskew-Überprüfung mit Anweisungen Modelle mit <4 GHz: 067-0405-xx

Modelle mit 4 GHz: 067-0484-xx
Modelle mit >4 GHz: 067-1586-xx

CD mit Nero OEM Software 063-3781-xx
Eines der folgenden: Modelle mit

<4 GHz
Modelle mit
≥4 GHz

Nordamerika (Option A0) 161-0104-00 161-0213-00
Europa universal (Option A1) 161-0104-06 161-0209-00
Großbritannien (Option A2) 161-0104-07 161-0210-00
Australien (Option A3) 161-0104-05 161-0211-01
Schweiz (Option A5) 161-0167-00 161-0212-00
Japan (Option A6) 161-A005-00 161-0213-00
China (Option A10) 161-0306-00 161-0320-00
Indien (Option A11) 161-0324-00 161-0325-00

Netzkabel

Kein Netzkabel oder Netzteil (Option A99) — —
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Betriebsvoraussetzungen
1. Stellen Sie das Gerät auf einen

Rollwagen oder einen Labortisch,
und beachten Sie die erforderlichen
Abstände und Abmessungen:

Modelle mit <4 GHz Modelle mit ≥4 GHz
Oben: 0 mm 0 mm
Linke und rechte Seite: 76 mm 76 mm
Unten: 0 mm, auf Füßen stehend,

Klappsockel unten
0 mm, auf Füßen stehend,
Klappsockel unten

Hinten: 0 mm, auf den hinteren Füßen 0 mm, auf den hinteren Füßen
2. Breite: 456 mm 451 mm
3. Höhe: 227 mm 292 mm
4. Überprüfen Sie vor der Inbetriebnahme

des Geräts die Umgebungstemperatur:
+5 °C bis +45 °C. +5 °C bis +45 °C.

5. Überprüfen Sie die Betriebsluft-
feuchtigkeit:

8 % bis 80 % relative
Luftfeuchtigkeit bei einer WBGT
von +29 °C bei max. +45 °C, nicht
kondensierend
Oberer Grenzwert
leistungsvermindert auf 30 %
relative Luftfeuchtigkeit bei +45 °C

8 % bis 80 % relative
Luftfeuchtigkeit bei maximal
+32 °C
5 % bis 45% relative
Luftfeuchtigkeit oberhalb
von +32 °C bis zu +45 °C,
nichtkondensierend und begrenzt
durch eine maximale WBGT von
+29,4 °C (Absenkung der relativen
Luftfeuchtigkeit auf 32 % bei +45
°C)

6. Überprüfen Sie die Höhe über NN: Modelle mit <4 GHz: 3000 m Modelle mit ≥4 GHz: 3000 m, max.
Betriebstemperatur um 1 °C pro
300 m oberhalb von 1500 m Höhe
über NN herabsetzen.

7. Maximale Eingangsspannung, Modelle
mit <4 GHz:
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50 Ω
1 MΩ

5 Veff, mit Spitzen ≤ ±24 V
150 V, Leistungsminderung bei 20 dB/Dekade bis 9 Veff bei über 200 KHz.
Die maximale Eingangsspannung am BNC-Anschluss zwischen Innenleiter
und Erdung beträgt 400 V als Spitzenwert. Die Effektivspannung ist
für arbiträre Signale, einschließlich Gleichstrom, auf <150 V begrenzt.
Die maximale Impulsbreite für Impulse mit Spitzenwerten über 150 V
beträgt 50 μs. Beispiel: Bei einem Spitzenwert von 0 V bis 400 V für
ein Rechtecksignal beträgt das Tastverhältnis 14 %. Die maximale
Stehstoßspannung beträgt ± 800 V Spitze.

Maximale Eingangsspannung, Modelle mit
≥4 GHz:

50 Ω <1 Veff für <1V/FS-Einstellungen und < 5,5 Veff für ≥1 V/FS-Einstellungen.

VORSICHT. Halten Sie beide Seiten des Geräts und den Boden frei, um die erforderliche Kühlung zu gewährleisten.
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Einschalten des Instruments
Stromversorgung - Voraussetzungen
Stromspannung und -frequenz Stromverbrauch
Modelle mit <4 GHz: 100 bis 240 Veff ±10 %, 47 bis 63 Hz
oder 115 Veff ±10 %, 400 Hz

550 W, max.

Modelle mit ≥4 GHz: 100 bis 240 Veff ±10 %, 50 bis 60 Hz
oder 115 Veff ±10 %, 400 Hz. CAT II (Kategorie II)

≤ 1100 VA

Modelle mit <4 GHz

Modelle mit ≥4 GHz
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Ausschalten des Instruments

Stromversorgung trennen

Modelle mit <4 GHz

Modelle mit ≥4 GHz
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Verbindung zu einem Netzwerk herstellen
Sie können Ihr Instrument in ein Netzwerk
einbinden, um über das Netzwerk
zu drucken, Dateien auszutauschen,
aufs Internet zuzugreifen und andere
Funktionen auszuführen. Fragen Sie Ihren
Netzwerkadministrator, und verwenden
Sie die üblichen Windows-Funktionen,
um das Instrument in Ihrem Netzwerk zu
konfigurieren.

HINWEIS. Zum Aktivieren des Remote-Betriebs über das Netzwerk schalten Sie auf Display>Display Remote
(Anzeige>Remote-Anzeige) um. VNC oder pcAnywhere müssen auf dem Gerät und auf dem Remote-PC installiert sein. Bei
aktivierter Remote-Anzeige ist die Anzeige von Aktualisierungen sowie der Zugriff auf Steuerfenster und Menüelemente
langsam.

Hinzufügen eines zweiten Monitors
Sie können das Gerät bedienen und gleichzeitig Windows und installierte Anwendungen über einen externen Monitor
steuern. Um eine Konfiguration mit zwei Monitoren einzurichten, befolgen Sie die nachstehende Prozedur.
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1. Schalten Sie das Gerät aus.

2. Schließen Sie den zweiten Monitor an.

3. Schließen Sie die Tastatur an.

4. Schließen Sie die Maus an.

5. Schalten Sie das Gerät ein.

6. Schalten Sie den Monitor ein.

Modelle mit <4 GHz
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Installieren des Geräts

1. Schalten Sie das Gerät aus.

2. Schließen Sie den zweiten Monitor an.

3. Schließen Sie die Tastatur an.

4. Schließen Sie die Maus an.

5. Schalten Sie das Gerät ein.

6. Schalten Sie den Monitor ein.

Modelle mit ≥4 GHz
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7. Klicken Sie mit der rechten Maustaste
auf den Desktop von Windows, und
wählen Sie dann Eigenschaften aus.

8. Wählen Sie Einstellungen aus. Klicken
Sie auf den grau unterlegt dargestellten
externen Monitor (2), und ziehen Sie ihn
an einen Platz links von Monitor 1.

9. Nach der Aufforderung, den neuen
Monitor zu aktivieren, wählen Sie Ja aus.

10. Klicken Sie auf Übernehmen.

11. Um das Gerät neu zu starten, klicken Sie
auf Ja.
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Erstellen von CD-ROMs zur Betriebssystem-Wiederherstellung
Das Gerät wird nicht mit einer DVD zum Wiederherstellen des Betriebssystems geliefert. Führen Sie die folgenden Schritte
durch, um einen Satz CD-ROMs zu erstellen, mit denen Sie das Betriebssystem bei Bedarf wiederherstellen können.

HINWEIS. Mit dieser Vorgehensweise wird ein Satz von Wiederherstellungs-CD-ROMs für das Microsoft
Windows-Betriebssystem erstellt. Verwenden Sie nach der Wiederherstellung des Betriebssystems die Produktsoftware-CD,
um die Anwendungssoftware für das Gerät erneut zu installieren. Folgen Sie den mit der Produktsoftware-CD gelieferten
Anweisungen, um die Anwendungssoftware für das Gerät erneut zu installieren.

Erstellen von Wiederherstellungs-CD-ROMs
Voraussetzungen. Leere CD-R-Datenträger (einen für jede Sicherungsdatei).

So erstellen Sie einen Satz von Wiederherstellungs-CD-ROMs:

1. Legen Sie eine leere CD-R in das DVD-Laufwerk des Geräts ein.

2. Klicken Sie auf Start > All Programs > Nero 7 Essentials > Data > Nero Express Essentials (Start > Alle Programme >
Nero 7 Essentials > Daten > Nero Express Essentials).

3. Klicken Sie auf Image, Project, Copy (Image, Projekt, Kopie).

4. Klicken Sie auf Disk Image (Datenträger-Image) oder Saved Project (Gespeichertes Projekt).

5. Navigieren Sie zu C:\backup.

6. Wählen Sie die Datei backup1 (Sicherung1) aus und klicken Sie auf Open (Öffnen).

7. Aktivieren Sie das Kontrollkästchen Verify data on disk after burning (Daten auf Datenträger nach Brennvorgang
überprüfen).

8. Klicken Sie auf die Schaltfläche Burn (Brennen). Die Anwendung schreibt die Sicherungsdatei auf die CD-R und
überprüft dann, ob die Daten auf der CD mit der Quelldatei übereinstimmen.

9. Wenn die Anwendung berichtet, dass der Schreibprozess auf CD erfolgreich abgeschlossen wurde, entfernen Sie die
CD-R und beschriften Sie sie entsprechend (inklusive Name der Sicherungsdatei, Gerätename, Seriennummer des
Geräts und Datum).

10. Wiederholen Sie die Schritte 1 bis 9 für alle verbleibenden Sicherungsdateien.

11. Kopieren Sie die Datenträger-Imagedateien (*.iso) aus dem Verzeichnis C:\backup zu Sicherungszwecken an einen
Speicherort im Netzwerk, auf eine separate Festplatte oder auf ein optisches Medium.

12. Lagern Sie die Sicherungs-CDs wie von Ihren Firmenrichtlinien vorgesehen.

HINWEIS. Betriebssystem-Wiederherstellungsdatenträger können nur auf dem Gerät verwendet werden, auf dem Sie
erstellt wurden.
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Umgang mit dem Gerät

Vorderseite
1. DVD/CD-RW-Laufwerk

2. Steuerelemente auf der Frontplatte

3. USB-Schnittstelle

4. Erdungsklemme

5. Datenrückgewinnungsausgang

6. Taktrückgewinnungsausgang

7. Tastkopfkompensationsausgang

8. Tastkopfkalibrierungsausgang

9. Eingang für die Kanäle 1-4

10. Zusätzlicher Triggereingang

11. Ausgang mit schnell ansteigender Flanke

12. Gleichspannungsausgang mit
Tastkopfkalibrierung Modelle mit <4 GHz

Modelle mit ≥4 GHz
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Seitenteile und Rückwand
1. USB-Schnittstellen

2. Videoanschluss zum Anschließen eines
Monitors für die Anzeige nebeneinander

HINWEIS. Einige Geräte verfügen
möglicherweise über zusätzliche
Audioanschlüsse.

3. Mic-Stecker für das Mikrofon

4. Line-Out-Stecker für den Lautsprecher

5. Scope Only XGA Out-Videoanschluss
zum Anschließen eines Monitors

6. Druckerverbindung

7. Line-In-Stecker

8. RJ-45-LAN-Stecker für den Anschluss
an ein Netzwerk.

9. Parallele Schnittstelle (Centronics)

10. Serielle Schnittstelle COM 1

11. PS-2-Anschluss für die Maus

12. PS-2-Anschluss für die
Tastatur

13. TekLink-Stecker für künftige Zwecke

14. Entnehmbares Festplattenlaufwerk

15. GPIB-Schnittstelle für den Anschluß an
den Controller

16. Zusätzlicher Ausgang

17. Ausgang für Kanal 3

18. Externer Referenzeingang

Modelle mit <4 GHz
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1. Entnehmbares Festplattenlaufwerk

2. PS-2-Anschluss für die Maus

3. USB-Schnittstellen

4. Parallele Schnittstelle (Centronics)

5. RJ-45-LAN-Stecker für den Anschluss
an ein Netzwerk.

6. Videoanschluss zum Anschließen eines
Monitors

7. TekLink-Stecker

8. GPIB-Schnittstelle für den Anschluß an
den Controller

HINWEIS. Einige Geräte verfügen
möglicherweise über zusätzliche
Audioanschlüsse.

9. Line-In-Stecker

10. Line-Out-Stecker für den Lautsprecher

11. Mic-Stecker für das Mikrofon

12. Videoanschluss zum Anschließen eines
Monitors für die Anzeige nebeneinander

13. Serielle Schnittstelle COM 1

14. PS-2-Anschluss für die Tastatur

15. Zusätzlicher Ausgang

16. Referenzausgang

17. Externer Referenzeingang

Modelle mit ≥4 GHz
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Schnittstelle und Anzeige
Im Menüleistenmodus erhalten Sie Zugriff auf die Befehle, die alle Gerätemerkmale und Gerätefunktionen steuern. Die
Symbolleiste bietet Zugriff auf die wichtigsten Funktionen.

1. Menüleiste: Zugriff auf Daten-E/A,
Druck, Online-Hilfe und Gerätefunktionen

2. Schaltflächen/Menü: Klicken
Sie darauf, um zwischen dem
Symbolleistenmodus und dem
Menüleistenmodus zu wechseln und um
die Symbolleiste individuell anzupassen.

3. Anzeigen des Mehrfunktions-
Drehknopfs: Anpassen und
Anzeigen der mithilfe der
Mehrfunktions-Drehknöpfe gesteuerten
Parameter

4. Anzeige: Hier werden direkt erfasste,
Referenz- und mathematische Signale
zusammen mit den Cursorn angezeigt

5. Signal-Ziehpunkt: Durch Klicken und
Ziehen können Sie die vertikale Position
des Signals ändern. Klicken Sie auf den
Ziehpunkt, und ändern Sie mithilfe der
Mehrfunktions-Drehknöpfe die Position
und die Skala.

6. Status der Steuerelemente:
Kurzinformationen zu vertikalen
Auswahlen, Skala, Offset und
Parametern

7. Anzeigen: In diesem Bereich werden
Cursor- und Messwertausgaben
angezeigt. Über die Menüleiste oder
Symbolleiste können Messungen
ausgewählt werden. Bei der Anzeige
eines Steuerungsfensters werden einige
Kombinationen von Anzeigen in den
Rasterbereich verschoben.
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WARNUNG. Bei Vorliegen vertikaler
Signalamplitudenbegrenzungen können an
der Tastkopfspitze gefährliche Spannungen
auftreten, auch wenn in der Anzeige eine
niedrige Spannung angegeben wird. In der
Messwertanzeige leuchtet ein Symbol
auf, wenn eine Signalamplitudenbegrenzung
vorliegt. Automatische amplitudenbezogene
Messungen, bei denen das Signal vertikal
begrenzt ist, liefern ungenaue Ergebnisse.
Signalamplitudenbegrenzungen verursachen
auch ungenaue Amplitudenwerte in
Signalen, die für die Verwendung in anderen
Programmen gespeichert oder exportiert
werden. Wenn ein mathematisches
Signal beschnitten wird, hat dies keine
Auswirkungen auf die Amplitudenmessungen
für dieses berechnete Signal.

8. Status: Anzeige von Erfassungsstatus,
Modus und Anzahl der Erfassungen;
Triggerstatus; Datum, Uhrzeit
sowie Kurzinformationen zur
Aufzeichnungslänge und zu den
horizontalen Parametern

1. Schaltflächen/Menü: Klicken
Sie darauf, um zwischen dem
Symbolleistenmodus und dem
Menüleistenmodus zu wechseln und um
die Symbolleiste individuell anzupassen.

2. Ziehen Sie die Cursor zum Messen der
Signale auf den Bildschirm.

3. Ziehen Sie an den Positionssymbolen,
um ein Signal neu zu positionieren.

4. Um der vertikalen Position und
Skalierung des Signals die
Mehrfunktions-Drehknöpfe zuzuweisen,
klicken Sie auf das Symbol.

5. Ziehen Sie quer über den Signalbereich,
um ein Feld für das Zoomen, für das
Aktivieren bzw. Deaktivieren von
Histogrammen und für das Gating von
Messungen zu erstellen.

6. Durch Ziehen des Symbols können Sie
den Triggerpegel ändern.
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Systemsteuerung

1. Drücken Sie die Taste, um die vertikalen,
horizontalen und Triggeroptionen
entsprechend den ausgewählten
Kanälen automatisch festzulegen.

2. Drücken Sie die Taste, um die
Einstellungen auf die Standardwerte
zurückzusetzen.

3. Drücken Sie die Taste, um einen
Ausdruck zu erstellen oder eine
Bildschirmdarstellung zu speichern.

4. Drücken Sie die entsprechende Taste,
um den MultiView-Zoom einzuschalten
und die Anzeige durch ein vergrößertes
Raster zu ergänzen.

5. Hiermit können Sie alle Signale skalieren,
positionieren und verzögern sowie die
Aufzeichnungslänge (Auflösung) für
Signale festlegen.

6. Mithilfe dieser Tasten können Sie die
Erfassung starten und beenden, eine
Einzelfolgeerfassung beginnen, Daten
löschen oder Schnellerfassungen
starten.

7. In diesem Bereich werden die
Trigger-Parameter festgelegt. Drücken
Sie für die Anzeige der zusätzlichen
Trigger-Funktionen die Taste Advanced
(Erweitert). Der Erfassungsstatus wird
über die Anzeigen „Arm“ (Armiert),
„Ready“ (Bereit) und „Trig’d“ (Getriggert)
wiedergegeben.

8. Drehen Sie den entsprechenden
Drehknopf, um die Helligkeit des Signals
anzupassen.

9. Durch Drehen des Drehknopfs können
Sie die auf der Bildschirmschnittstelle
ausgewählten Parameter anpassen.
Drücken Sie die Taste, um zwischen
normaler und Feineinstellung
umzuschalten.

10. Durch Drücken der entsprechenden
Taste werden die Cursor aktiviert bzw.
deaktiviert.
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11. Drücken Sie diese Taste, um den
berührungsempfindlichen Bildschirm zu
aktivieren oder zu deaktivieren.

12. Aktivieren oder deaktivieren Sie die
Kanalanzeigen. Nehmen Sie das
vertikale Skalieren, Positionieren oder
den Offset für das Signal vor. Schalten
Sie zwischen Position und Offset um.
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Zugriff auf die Online-Hilfe
In der Online-Hilfe finden Sie zu allen Gerätefunktionen ausführliche Informationen.

Um auf die kontextsensitive Hilfe zum aktiven
Fenster zuzugreifen, wählen Sie Help > Help
on Window... (Hilfe > Hilfe zum Fenster)
aus, oder drücken Sie F1.

1. Um auf ein Thema im Hilfesystem
zuzugreifen, wählen Sie Help >
Contents and Index... (Hilfe > Inhalt
und Index) aus.

2. Wählen Sie auf einer der Registerkarten
Contents (Inhalt), Index, Search (Suche)
oder Favoriten das gewünschte Thema
aus, und klicken Sie dann auf Display
(Anzeigen).

So können Sie im Hilfesystem navigieren:

Klicken Sie auf eine Schaltfläche im
Hilfefenster, um zwischen der Übersicht
und konkreten Themen zu navigieren.

Klicken Sie in einem Hilfefenster auf die
Schaltfläche Minimize (Minimieren), um
den Hilfetext soweit zu verkleinern, dass
Sie das Gerät bedienen können.

Drücken Sie Alt und Tab, um das letzte
Hilfethema noch einmal anzuzeigen.
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Zugriff auf Menüs und Steuerungsfenster
Auf folgende Weise können Sie auf die Menüs und Steuerungsfenster zugreifen:

Klicken Sie auf ein Menü, und wählen
Sie dann einen Befehl aus.

Klicken Sie mit der rechten Maustaste
auf eine beliebige Stelle im Raster oder
auf einem Objekt, um das Kontextmenü
anzuzeigen. Das Kontextmenü ist
kontextsensitiv und ändert sich je nach
dem Bereich oder Objekt, auf den oder
das mit der rechten Maustaste geklickt
wurde. In der Abbildung rechts finden
Sie einige Beispiele.

Im Symbolleistenmodus klicken Sie auf
eine Schaltfläche, um schnell auf ein
Steuerungsfenster für Einstellungen
zuzugreifen. (Siehe Seite 14.)
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Überprüfen des Geräts
Überprüfen Sie anhand der folgenden Prozeduren die Funktionstüchtigkeit des Geräts.

Bestehen der internen Diagnoseprüfung.
1. Schalten Sie das Gerät ein.

2. Wählen Sie Instrument Diagnostics...
(Gerätediagnose) aus.
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3. Klicken Sie auf Run (Ausführen).
Die Testergebnisse werden im
Diagnosesteuerungsfenster angezeigt.

4. Stellen Sie sicher, dass alle Tests
erfolgreich durchgeführt wurden. Im
Falle von Diagnosefehlern wenden Sie
sich an das nächstgelegene Tektronix
Kundendienstbüro.

Signalpfadkompensation
Wenn sich seit der letzten Signalpfadkompensation die Temperatur um mehr als 5 °C geändert hat, führen Sie folgende
Schritte durch. Führen Sie die Signalpfadkompensation einmal wöchentlich durch. Sollten Sie dies unterlassen, kann es zur
Folge haben, dass das Gerät nicht das garantierte Leistungsniveau erreicht.

1. Voraussetzungen: Das Gerät ist seit
20 Minuten eingeschaltet, und alle
Eingangssignale wurden entfernt.

2. Wählen Sie Instrument Calibration
(Gerätekalibrierung) aus.
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3. Wenn der Status in Temp übergeht,
klicken Sie auf Kalibrieren, um die
Kalibrierung zu starten. Die Kalibrierung
kann 10 bis 15 Minuten dauern.

4. Wenn das Gerät den Pass/Fail-Test
nicht besteht, kalibrieren Sie das Gerät
neu oder lassen es von qualifiziertem
Kundendienstpersonal warten.
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Erfassung
In diesem Abschnitt werden Konzepte und Verfahren zur Verwendung des Erfassungssystems beschrieben.

Einrichten der Signaleingabe
Richten Sie mit Hilfe der Tasten auf der Frontplatte das Gerät für die Erfassung des Signals ein.

1. Schließen Sie den Tastkopf an die Quelle
des Eingangssignals an.

Modelle mit <4 GHz

Modelle mit ≥4 GHz

2. Wählen Sie den Eingangskanal durch
Drücken der Tasten auf dem vorderen
Bedienfeld aus. Dadurch werden die
Kanäle ein- und ausgeschaltet.
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3. Drücken Sie Autoset.

4. Regeln Sie mithilfe der Knöpfe auf
dem vorderen Bedienfeld die vertikale
Position, Skalierung und das Offset
ein. (Indem Sie auf den Knopf drücken,
können Sie zwischen Position und Offset
umschalten.)

5. Regeln Sie mithilfe der Knöpfe auf dem
vorderen Bedienfeld die horizontale
Position, Skalierung und das Offset ein.
Die horizontale Position bestimmt
die Anzahl der Vortrigger- und der
Nachtrigger-Abtastwerte.

Verwenden der Grundeinstellung
1. Um die Einstellungen schnell auf die

werkseitigen Standardeinstellungen
zurückzusetzen, drücken Sie die Taste
GRUNDEINSTELLUNG.
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Verwendung von Auto-Setup
Mit Auto-Setup können Sie schnell und automatisch das Gerät (horizontale, Trigger- und vertikale Erfassung) entsprechend
den Eigenschaften des Eingangssignals einrichten. Die Funktion Auto-Setup passt das Signal so an, dass zwei oder drei
Signalzyklen mit dem Trigger etwa in der Mitte angezeigt werden.

1. Schließen Sie den Tastkopf an,
und wählen Sie anschließend den
Eingangskanal aus. (Siehe Seite 23,
Einrichten der Signaleingabe.)

2. Drücken Sie die Taste AUTO-SETUP,
um Auto-Setup auszuführen.

3. Klicken Sie auf Undo (Rückgängig), um
das zuletzt vorgenommene Auto-Setup
rückgängig zu machen. Parameter, auf
die das Auto-Setup keinen Einfluss hat,
behalten ihre Einstellungen.

Schnelltipps
Auto-Setup verändert gegebenenfalls die vertikale Position, um das Signal richtig zu positionieren. Mit Autoset kann
auch der vertikale Offset eingestellt werden.

Wenn ein oder mehrere Kanäle angezeigt werden und Sie Auto-Setup verwenden, wählt das Gerät den Kanal mit der
niedrigsten Nummer für die horizontale Skalierung und Triggerung aus. Sie können für jeden Kanal einzeln die vertikale
Skalierung steuern.

Wenn Sie Auto-Setup verwenden, ohne dass ein Kanal angezeigt wird, schaltet das Gerät auf Kanal eins (Ch 1)
und skaliert diesen.

Schließen Sie das Steuerungsfenster „Autoset Undo" (Auto-Setup rückgängig), indem Sie auf X klicken. Nachdem
dieses Fenster geschlossen wurde, können Sie immer noch den letzten Auto-Setup rückgängig machen, indem Sie den
Befehl „Undo Last Autoset“ (Letzten Auto-Setup zurücksetzen) im Menü „Edit“ (Bearbeiten) auswählen.

Sie können verhindern, dass sich das Steuerungsfenster „Autoset Undo" (Auto-Setup Rückgängig) automatisch öffnet,
indem Sie die Benutzereinstellungen im Menü „Utilities" (Dienstprogramm) ändern.
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Tastkopfkompensation, Tastkopfkalibrierung und Deskew
Zum Optimieren der Messgenauigkeit lesen Sie bitte in der Online-Hilfe zum Gerät nach und führen die folgenden
Prozeduren aus:

Passive Tastköpfe kompensieren

Den Gerätesignalpfad kompensieren

Aktive Tastköpfe kalibrieren

Deskew der Eingangskanäle vornehmen

Erfassungskonzepte
Erfassungshardware
Bevor ein Signal angezeigt werden kann, muss es durch den Eingangskanal geleitet werden, in dem es skaliert und
digitalisiert wird. Jeder Kanal verfügt über einen dedizierten Eingangsverstärker und -digitalisierer. Jeder Kanal erzeugt
einen digitalen Datenstrom, aus dem das Gerät Signalaufzeichnungen extrahiert.

Abtastverfahren

Die Erfassung besteht aus dem Abtasten
eines analogen Signals, dem Konvertieren
des Signals in digitale Daten und
dem Zusammenstellen der Daten in
einer Signalaufzeichnung, die dann im
Erfassungsspeicher gespeichert wird.

Abtastung in Echtzeit

Bei der Echtzeit-Abtastung digitalisiert
das Gerät alle erfassten Punkte mit Hilfe
eines Triggerereignisses. Nehmen Sie die
Echtzeit-Abtastung vor, um Einzelschuss-
oder einmalige Ereignisse zu erfassen.
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Interpolierte Echtzeit-Abtastung

Bei der interpolierten Echtzeit-Abtastung
digitalisiert das Gerät alle erfassten Punkte
mit Hilfe eines Triggerereignisses. Wenn das
Gerät bei maximaler Echtzeit-Abtastrate nicht
genügend Abtastwerte für ein vollständiges
Signal erfasst, erfolgt Interpolation. Nehmen
Sie die interpolierte Echtzeit-Abtastung vor,
um Einzelschuss- bzw. einmalige Ereignisse
zu erfassen sowie langsame Erfassungen
vorzunehmen.

Äquivalentzeit-Abtastung

Das Gerät nimmt eine Äquivalentzeit-
Abtastung vor, um die Abtastrate über die
maximale Abtastrate in Echtzeit hinaus
zu erhöhen. Die Äquivalentzeit-Abtastung
wird nur verwendet, wenn Äquivalentzeit
ausgewählt wurde und die Zeitbasis auf
eine Abtastrate festgelegt wurde, die
zu schnell ist, um Signale mithilfe der
Echtzeit-Abtastung aufzuzeichnen.
Das Gerät nimmt mehrere Erfassungen
eines sich wiederholenden Signals vor, um
die für eine vollständige Signalaufzeichnung
erforderliche Abtastdichte zu erzielen. Daher
sollte Äquivalentzeit-Abtastung nur bei sich
wiederholenden Signalen erfolgen.
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Signalaufzeichnung

Das Gerät erstellt die Signalaufzeichnung
mit Hilfe der folgenden Parameter:

Abtastintervall: Die Zeit zwischen
Abtastpunkten.

Aufzeichnungslänge: Die erforderliche
Anzahl von Abtastpunkten für eine
Signalaufzeichnung.

Triggerpunkt: Der Bezugsnullpunkt in
einer Signalaufzeichnung.

Horizontale Position: Wenn die
horizontale Verzögerung ausgeschaltet
ist, ist die horizontale Position eine
Prozentzahl der Signalaufzeichnung
zwischen 0 und 99,9 %. Der Triggerpunkt
und die horizontale Referenz befinden
sich zum gleichen Zeitpunkt in
der Signalaufzeichnung. Wenn
beispielsweise die horizontale
Position 50 % beträgt, dann
befindet sich der Triggerpunkt in
der Mitte der Signalaufzeichnung.
Wenn die horizontale Verzögerung
eingeschaltet ist, handelt es sich bei der
Zeitspanne vom Triggerpunkt bis zur
horizontalen Referenz um die horizontale
Verzögerung.

Interpolation
Das Gerät kann zwischen den erfassten Abtastwerten interpolieren, wenn nicht alle tatsächlich benötigten Abtastwerte
vorliegen, um die Signalaufzeichnung aufzufüllen. Durch lineare Interpolation werden die Aufzeichnungspunkte zwischen
den tatsächlich erfassten Abtastwerten mithilfe einer linearen Ausgleichung berechnet.

Die Sin(x)/x-Interpolation berechnet Aufzeichnungspunkte mithilfe einer Kurvenanpassung zwischen den tatsächlich
erfassten Werten. Bei der Sin(x)/x-Interpolation handelt es sich um den Standardinterpolationsmodus, weil dafür weniger
tatsächliche Abtastpunkte als bei der linearen Interpolation zur genauen Signaldarstellung benötigt werden.

So funktioniert der Signalerfassungsmodus

Im Modus Sample (Abtastung) wird der erste
Abtastpunkt aus jedem Erfassungsintervall
zurückbehalten. Dieser Modus ist der
Standardmodus.
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Bei Peak Detect (Spitzenwerterfassung)
wird jeweils der höchste und niedrigste
Abtastwert aus zwei aufeinanderfolgenden
Erfassungsintervallen verwendet. Dieser
Modus funktioniert nur bei der nicht
interpolierten Abtastung in Echtzeit und ist
für das Erfassen von Hochfrequenz-Glitches
geeignet.
Im Hi Res-Modus (hohe Auflösung) wird
der Durchschnittswert für alle Abtastwerte
eines Erfassungsintervalls ermittelt. Der
Hi Res-Modus bietet ein Signal mit höherer
Auflösung und geringerer Bandbreite.
Der Modus Envelope (Hüllkurvenmodus)
identifiziert die höchsten und niedrigsten
aufgezeichneten Punkte in einer Reihe von
Erfassungen. Für die einzelnen Erfassungen
wird die Spitzenwerterfassung verwendet.
Im Modus Average (Mittelwertmodus) wird
der Mittelwert für jeden aufgezeichneten
Punkt über eine Reihe von Erfassungen
berechnet. Die Mittelwertbildung verwendet
den Abtastmodus für alle Einzelerfassungen.
Verwenden Sie den Mittelwertmodus, um
unkorreliertes Rauschen zu verringern.
Bei dem Modus Waveform Database
(Signaldatenbank) handelt es sich um
eine dreidimensionale Akkumulation von
Quellsignaldaten über mehrere Erfassungen.
Neben Informationen zu Amplitude und Zeit
enthält die Datenbank eine Zählung, wie
oft ein bestimmter Silgnalpunkt (Zeit und
Amplitude) erfasst wurde.
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Ändern des Erfassungsmodus
So ändern Sie den Erfassungsmodus:

1. Wählen Sie den Horiz/Acq >
Acquisition Mode (Horiz/Erfass.
> Erfassungsmodus) aus.

2. Um einen Erfassungsmodus
auszuwählen, gehen Sie
folgendermaßen vor:

Wählen Sie einen Erfassungsmodus
direkt über das Menü aus.

Klicken Sie auf Mode... (Modus),
und wählen Sie dann einen
Erfassungsmodus aus.

3. Klicken Sie zum Einstellen der
Erfassungsmodi "Mittelwert" oder
"Hüllkurve" auf das Steuerelement # of
Wfms (Anzahl der Signale). Stellen Sie
dann mit dem Mehrfunktions-Drehknopf
die Anzahl der Signale ein. Um den
Modus WfmDB einzustellen, klicken
Sie auf das Steuerelement Samples
(Abtastwerte) und legen dann die
Anzahl der Abtastwerte mit dem
Mehrfunktions-Drehknopf fest.

Schnelltipp
Klicken Sie auf das Tastenfeldsymbol, um die Anzahl der Signale oder Abtastwerte festzulegen.
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Starten und Anhalten einer Erfassung
Nachdem die Kanäle, die erfasst werden sollen, ausgewählt wurden, führen Sie folgende Schritte durch.

1. Drücken Sie auf der Frontplatte die Taste
RUN/STOP (AUSFÜHREN/BEENDEN),
um die Erfassung zu starten.

2. Drücken Sie die Taste RUN/STOP
(AUSFÜHREN/BEENDEN) erneut, um
die Erfassung zu beenden.

3. Um eine Einzelerfassung vorzunehmen,
drücken Sie die Taste Single (Einzeln).

Auswählen des horizontalen Modus
Ihr Gerät verfügt über drei horizontale Modi. Automatic (Automatisch) ist der Standardmodus. Wählen Sie den horizontalen
Modus aus, der für Ihre Testeinstellungen am besten geeignet ist.

Zum Festlegen des horizontalen
Modus wählen Sie Horiz/Acq >
Horizontal/Acquisition Setup (Horiz/Erfass.
> Einstellung Horizontale Erfassung)
aus. Damit wird das horizontale
Steuerungsfenster angezeigt. Wählen Sie
einen der nachstehend beschriebenen Modi
aus.

Im Modus Automatic (Automatisch) können
Sie die Skala und die Abtrastrate festlegen.
Die Aufzeichnungslänge ist eine abhängige
Variable. Wenn beim Ändern der Skala
die Aufzeichnungslänge die Obergrenze
für die Aufzeichnungslänge überschreiten
würde, wird die Abtastrate auf die nächste
verfügbare Einstellung gesenkt.
Wenn als Abtastmodus Echtzeitmodus
vorliegt und sich die Abtastrate am
Echtzeit-Oberwert befindet, ist jeglicher
Versuch, die Abtastrate zu erhöhen,
wirkungslos.
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Zum Festlegen der Obergrenze der
Aufzeichnungslänge klicken Sie auf
Record Length Limit (Obergrenze der
Aufzeichnungslänge) und legen den
Grenzwert mit Hilfe der Schaltflächen oder
des Tastenfelds fest. Der Standardwert
für die maximale Obergrenze ist vom
Gerätemodell und von der Option für die
Aufzeichnungslänge abhängig.

Im Modus Constant Sample Rate (Konstante
Abtastrate) können Sie die Abtastrate
(Sample Rate) und die Skala (Scale)
festlegen. Bei der Standardabtastrate ist
gewährleistet, dass der Bandbreitenfilter
funktioniert. Die Aufzeichnungslänge
ist eine abhängige Variable. Die
maximale Aufzeichnungslänge hängt
vom Gerätemodell und der Option für die
Aufzeichnungslänge ab.
Mit dem Knopf für Resolution (Auflösung) auf
dem vorderen Bedienfeld kann die Abtastrate
sowohl im automatischen Modus als auch
im Modus Constant Sample Rate (Konstante
Abtastrate) geändert werden.
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Im Modus Manual (Manuell) können Sie
die Abtastrate und die Aufzeichnungslänge
festlegen. Die horizontale Skala ist eine
abhängige Variable, die aus Abtastrate und
Aufzeichnungslänge berechnet wird. Im
manuellen Modus werden Masken nicht
unterstützt.
Mit dem Knopf Horizontal Scale (Horizontale
Skala) ändern Sie die Aufzeichnungslänge
manuell.

Alle drei Modi interagieren, wie die
Abbildung zeigt, mit der Abtastrate,
Skala und Aufzeichnungslänge. Die
horizontale Linie repräsentiert die maximale
Echtzeitabtastrate. Jede Treppenlinie
zeigt, dass beim Vergrößern der Skala die
Abtastrate verringert werden muss, wenn
entweder die maximale Aufzeichnungslänge
oder der von Ihnen festgelegte Grenzwert
für die Aufzeichnungslänge erreicht ist.
Im manuellen Modus wird die maximale
Aufzeichnungslänge verwendet.
Die Modi Automatic (Automatisch) und
Constant Sample Rate (konstante Abtastrate)
sind identisch. Im Modus Constant Sample
Rate (Konstante Abtastrate) wird die
Abtastrate konstant auf einem Wert gehalten,
bei dem die Verwendung der Filter für die
Bandbreitenvergrößerung gewährleistet ist.
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Verwendung von FastAcq
Der Schnellerfassungsmodus verringert die Totzeit zwischen Signalerfassungen und ermöglicht die Erfassung und Anzeige
von einmaligen Ereignissen, z. B. Glitches oder Runt-Impulsen. Im Schnellerfassungsmodus können Signalphänomene
auch mit einer Intensität dargestellt werden, die deren Vorkommenshäufigkeit widerspiegelt.

Gehen Sie folgendermaßen vor:

1. Drücken Sie FastAcq
(Schnellerfassung).

2. Suchen Sie nach Glitches, einmaligen
oder anderen zufälligen Ereignissen.
Wenn Sie eine Anomalie festgestellt
haben, richten Sie das Triggersystem ein,
um danach zu suchen. (Siehe Seite 125,
Erfassen von intermittierenden
Anomalien.)

Schnelltipps
Um die Erfassung von Einzelheiten oder seltenen Ereignissen zu optimieren, wählen Sie Horiz/Acq >
Horizontal/Acquisition Setup > Acquisition > Fast Acq (Horiz/Erfass.> Horizontal/Erfassungseinstellung> Erfassung
> Schnellerf.) aus, und danach wählen Sie Optimize For (Optimieren für) Capturing Details (Erfassen von Details) oder
Capturing rare events (Erfassen seltener Ereignisse) aus.

Verwenden der vergrößerten DSP-Bandbreite
Wenn das Gerät über die Funktion der Bandbreitenvergrößerung verfügt, können Sie die vergrößerte DSP-Bandbreite
(Digital Signal Processing; digitale Signalverarbeitung) verwenden, um für genauere Anstiegszeitmessungen die Bandbreite
zu vergrößern und bei voller Abtastrate den Durchlassbereich abzuflachen. Bei der vergrößerten Bandbreite wird eine
abgestimmte Antwort über die aktivierten Kanäle hinweg bereitgestellt. Dadurch können Sie einen Vergleich der Kanäle
untereinander und Differenzmessungen vornehmen.
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1. Drücken Sie AUTOSET (Auto-Setup),
um die horizontalen, vertikalen und
Triggersteuerelemente festzulegen
bzw. um die Steuerelemente manuell
festzulegen.

2. Wählen Sie Vertical > Bandwidth
Enhanced... (Vertikal, Vergrößerte
Bandbreite) aus.
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3. Klicken Sie auf Digital Filters
(DSP) Enhanced (Digitale Filter (DSP)
erweitert), um die vergrößerte Bandbreite
zu aktivieren. Zum Aktivieren von DSP
(Digital Signal Processing; digitale
Signalverarbeitung) müssen Sie die
Abtastrate korrekt festlegen.

4. Aktivieren Sie die Option Force
Constant Sample Rate (Konstante
Abtastrate erzwingen), um eine
konstante Abtastrate zu erzwingen, bei
der die DSP-Filter aktiviert sind.

HINWEIS. Wenn nicht bereits festgelegt,
wird durch Auswählen der Konstanten
Abtastrate der horizontale Modus auf
Konstante Abtastrate festgelegt, eine
Abtastrate, die DSP ermöglicht, festgelegt
und eine DSP-Bandbreite ausgewählt.

5. Wählen Sie die gewünschte Bandbreite
aus der Liste Bandwidth (Bandbreite)
aus.
Die zur Auswahl stehenden Bandbreiten
hängen von Ihrem Gerät, dem Tastkopf
und der Tastkopfspitze ab.
Durch Auswahl von Analog Only (nur
analog) wird eine Hardwarebandbreite
ausgewählt.

6. Um Ihre Auswahl auf alle Kanäle
anzuwenden, aktivieren Sie Apply
To All Channels (Für alle Kanäle
übernehmen).
Wenn aufgrund unterschiedlicher
Messproben das Gerät nicht für alle
Kanäle gleiche Einstellungen festlegen
kann, legt das Gerät für jeden Kanal
die Bandbreite auf einen Wert fest, der
dem von Ihnen ausgewählten Wert am
nächsten kommt.

Nach Aktivieren der vergrößerten
Bandbreite wird in der vertikalen Anzeige
der Bandbreitenindikator BW+ angezeigt.

Schnelltipps
Klicken Sie mit der rechten Maustaste auf den Signalziehpunkt, um ein Menü anzuzeigen, in dem Sie die Kanalbandbreite
und andere erweiterte Einstellungen für die Bandbreite auswählen können.
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Die vergrößerte DSP-Bandbreite tritt bei maximaler Abtastrate auf.

Verwenden Sie die vergrößerte DSP Bandbreite, wenn die Anstiegszeiten der Signale weniger als 50 ps betragen.

Wählen Sie bei höherem Signaldurchsatz, bei übersteuerten Signalen und wenn Sie bevorzugen, Ihre eigene
DSP-Nachverarbeitung zu nutzen, Analog Only (Nur analog) aus.

Sie können die Bandbreite des Geräts begrenzen, indem Sie Vertical (Vertikal) > Bandwidth Limit (Grenzwert Bandbreite)
auswählen und danach die Bandbreite auswählen.
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Verwenden des Rollmodus
Im Rollmodus ähnelt die Anzeige einem Streifenschreiber für niederfrequente Signale. Im Rollmodus werden die erfassten
Datenpunkte schon während der laufenden Aufzeichnung angezeigt, ohne dass auf die vollständige Signalaufzeichnung
gewartet werden muss.

1. Wählen Sie Horiz/Acq >
Horizontal/Acquisition Setup
(Horizontal/Erfassungseinstellung) aus.

2. Falls dies nicht ausgewählt wurde,
klicken Sie auf die Registerkarte
Acquisition (Erfassung). Klicken Sie auf
Auto (Automatisch), um den Rollmodus
einzuschalten.

HINWEIS. Der Rollmodus erfordert den
Erfassungsmodus Sample (Abtastmodus),
Spitzenwerterfassung oder Hi Res (hohe
Auflösung).

3. So beenden Sie die Erfassung im
Rollmodus:

Wenn Sie sich nicht in der
Einzelfolgeerfassung befinden,
drücken Sie RUN/STOP
(AUSFÜHREN/BEENDEN), um
den Rollmodus zu beenden.

Wenn Sie sich in der
Einzelfolgeerfassung befinden,
werden die Erfassungen
im Rollmodus automatisch
beendet, wenn eine vollständige
Signalaufzeichnung erfasst wurde.

Schnelltipps
Beim Wechsel in die Erfassungsmodi Hüllkurve, Mittelwert oder WfmDB wird der Rollmodus ausgeschaltet.

Der Rollmodus wird deaktiviert, wenn Sie die Horizontalskala auf 50 ms/div oder schneller festlegen.
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Verwendung des Modus FastFrame
FastFrame ermöglicht Ihnen, viele Triggerereignisse als Einzelaufzeichnungen in einer größeren Aufzeichnung zu erfassen
und anschließend jede Aufzeichnung einzeln anzuzeigen und zu messen. Zeitmarken zeigen die absolute Triggerzeit für
einen bestimmten Frame und die relative Zeit zwischen Triggern von zwei bestimmten Frames an.

1. Drücken Sie AUTOSET (Auto-Setup),
um die horizontalen, vertikalen und
Triggersteuerelemente festzulegen
bzw. um die Steuerelemente manuell
festzulegen.

2. Wählen Sie Horiz/Acq > FastFrame
Setup (Horizontal/Erfassung,
FastFrame-Einstellung) aus.
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3. Drücken Sie FastFrame On (Ein).

4. Wählen Sie Frame Size (Framegröße)
und # of Events Frames (Anzahl der
Ereignisframes). Stellen Sie dann
mithilfe der Mehrfunktions-Drehknöpfe
jeden einzelnen Parameter ein. Die
Frameanzahl stellt die Anzahl der
erfassten Triggerereignisse dar. Bei
der Framegröße handelt es sich um die
Anzahl der Abtastwerte, die bei jedem
Triggerereignis (oder Frame) gespeichert
werden. Der Wert für die Frameanzahl
wird verringert, wenn zum Speichern
aller Aufzeichnungen nicht genügend
Speicher zur Verfügung steht.

5. Wählen Sie mithilfe der Steuerelemente
„Frame Viewing” (Frameanzeige) den
Rahmen aus, der angezeigt werden soll.

6. Zum Anzeigen mehrerer übereinander
gelagerter Frames wählen Sie die Option
„Overlay“ aus.

7. Mithilfe der Steuerelemente „Time
Stamps“ (Zeitmarken) wählen Sie die
Quelle für und die Frame-Nummer
des Referenz-Frames aus. Bei dem
Referenz-Frame handelt es sich um den
Anfangspunkt beim Messen der relativen
Zeit zwischen zwei Frames.

Schnelltipps
Verwenden Sie FastFrame, wenn Sie die mit dem jeweiligen Triggerereignis verbundenen Daten für weitere Analysen
oder Sichtprüfungen speichern möchten.

Verwenden Sie FastFrame, wenn Sie mehrere Ereignisse erfassen möchten, zwischen denen lange und für Sie
uninteressante Totzeiten auftreten.
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Die beste Anzeige von mehreren Frames erzielen Sie mit den Farbpaletten „Normal“, „Green“ (Grün) oder „Gray“ (Grau),
weil der ausgewählte dunkelblaue Frame bei der Verwendung von „Temp“ oder „Spectral“ kaum zu unterscheiden ist.

Verwenden von FastFrame Frame Finder
Mit Frame Finder können Sie in FastFrame nach einem Frame suchen, der sich von anderen unterscheidet.

1. Wählen Sie die Quelle der Frames in
FastFrame.

2. Legen Sie den Suchbereich durch
Eingeben von From Frame # (Ab Frame
Nr.) und To Frame # (Bis Frame Nr.)
fest.

3. Drücken Sie Run/Stop (Start/Stop), um
Erfassungen zu starten.

4. Drücken Sie Start, um die Suche zu
starten.
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Frame Finder sucht nach einem anderen
Frame und zeigt ihn an.

5. Wenn die Anomalie, nach der Sie
suchen, innerhalb des angezeigten
Frames nicht vorkommt, drücken Sie No
(Nein). Frame Finder sucht nach einem
anderen Frame.

6. Wenn die Anomalie, nach der Sie
suchen, innerhalb des angezeigten
Frames vorkommt, drücken Sie Yes (Ja).

7. Wenn die Suche abgeschlossen ist,
drücken Sie Stop.

8. Drücken Sie Run/Stop (Start/Stop), um
Erfassungen zu starten.
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Pinpoint-Trigger
Das Pinpoint-Triggersystem tritt bei erweiterten Triggertypen in Aktion, die mit A- und B-Triggern verwendet werden können.
Es kann die Triggerfolge zurücksetzen, wenn das B-Ereignis nicht nach einer bestimmten Anzahl von Ereignissen oder
nach einer bestimmten Zeit auftritt. Pinpoint-Trigger unterstützen die Erfassung von Ereignissen ausgehend von dem
komplexesten Triggerereignis oder der komplexesten Folge von Triggerereignissen.

In diesem Abschnitt werden Konzepte und Verfahren zur Verwendung des Triggersystems beschrieben.

Triggerungskonzepte
Triggerereignis
Das Triggerereignis legt den zeitlichen Nullpunkt in der Signalaufzeichnung fest. Alle Daten der Signalaufzeichnung haben
diesen Punkt als zeitliche Referenz. Das Gerät erfasst fortlaufend genügend Abtastpunkte und speichert diese, um den
Vortriggerbereich der Signalaufzeichnung zu füllen. Bei Auftreten eines Triggerereignisses beginnt das Gerät mit der
Erfassung der Abtastpunkte, um den Nachtriggerbereich der Signalaufzeichnung zu erstellen, der nach bzw. rechts vom
Triggerereignis angezeigt wird. Nachdem ein Trigger festgestellt wurde, nimmt das Gerät keine weiteren Trigger an, bevor
die Erfassung abgeschlossen wurde und die Holdoff-Zeit abgelaufen ist.

Triggermodi
Der Triggermodus bestimmt, wie sich das Gerät verhält, wenn kein Triggerereignis vorliegt:

Im normalen Triggermodus kann das Gerät nur Signale erfassen, wenn ein Trigger vorliegt. Wenn kein Trigger vorliegt,
wird auf dem Bildschirm die zuletzt erfasste Signalaufzeichnung angezeigt. Wenn keine vorherige Signalaufzeichnung
vorhanden ist, wird keine Signalaufzeichnung angezeigt.

Im Triggermodus „Auto“ kann das Gerät auch ein Signal erfassen, wenn kein Trigger vorliegt. Im automatischen
Modus wird ein Timer verwendet, der nach dem Eintreten eines Triggerereignisses startet. Wenn nicht ein anderes
Triggerereignis erkannt wird, bevor der Timer abläuft, erzwingt das Gerät einen Trigger. Der Zeitraum, in dem auf ein
Triggerereignis gewartet wird, hängt von der Zeitbasiseinstellung ab.

Im Modus „Auto“ wird das Signal in der Anzeige nicht synchronisiert, wenn Trigger aufgrund von fehlenden gültigen
Triggerereignissen erzwungen werden. Dies führt dazu, dass das Signal über die Anzeige zu rollen scheint. Wenn ein
gültiger Trigger auftritt, wird die Anzeige stabil.

Im Flankentriggermodus können Sie das Triggern des Instruments auch dadurch erzwingen, dass Sie im Steuerungsfenster
auf Force Trigger (Trigger erzwingen) klicken.

Wählen Sie den Triggermodus im Menü Trig > Mode (Trigger > Modus) aus. Weitere Informationen finden Sie in der
Online-Hilfe zum Gerät.

Trigger-Holdoff
Der Trigger-Holdoff kann bei der Stabilisierung der Triggerung hilfreich sein, weil damit der Zeitraum nach Beginn Erfassung
verlängert wird, in dem keine weiteren Trigger erkannt werden. Diese Verlängerung kann dem System dabei helfen, die
restlichen Ereignisse eines Ereignis-Bursts zu überspringen, und damit immer nur auf das erste Ereignis eines Bursts
zu triggern. Passen Sie den Holdoff an, um eine stabile Triggerung zu erreichen, wenn das Gerät auf unerwünschten
Triggerereignissen triggert.
Legen Sie den Trigger-Holdoff im Menü Trig > Holdoff (Trigger > Holdoff ) fest. Weitere Informationen finden Sie in der
Online-Hilfe zum Gerät.
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Trigger-Kopplung
Durch die Triggerkopplung wird bestimmt, welcher Teil des Signals an die Triggerschaltung übergeben wird. Bei
der Flankentriggerung können alle verfügbaren Kopplungsarten verwendet werden: Wechselstrom, Gleichstrom,
Niederfrequenzunterdrückung, Hochfrequenzunterdrückung und Rauschunterdrückung. Bei allen anderen Triggertypen wird
ausschließlich die DC-Kopplung verwendet.

Wählen Sie die Triggerkopplung im Menü Trig > A Event (Main) Trigger Setup (Trigger > Einstellung Ereignistrigger A
(Haupt-Trigger)) aus. Weitere Informationen finden Sie in der Online-Hilfe zum Gerät.

Horizontale Position
Die horizontale Position definiert, an welcher Stelle der Trigger in der Signalaufzeichnung auftritt. Daher können Sie
wählen, wie viel das Gerät vor und nach dem Triggerereignis erfasst. Der Teil der Aufzeichnung vor dem Trigger ist der
Vortriggerbereich. Der Teil nach dem Trigger ist der Nachtriggerbereich.

Die Vortriggerdaten können bei der Fehlerbehebung hilfreich sein. Beispiel: Sie möchten die Ursache für einen
unerwünschten Glitch in Ihrem Prüfaufbau ermitteln. Hierzu können Sie auf den Glitch triggern und den Vortrigger-Zeitraum
vergrößern, um Daten vor dem Glitch zu erfassen. Durch die Analyse der Daten vor dem Glitch erhalten Sie möglicherweise
Informationen zur Quelle des Glitches. Um festzustellen, was im System als Ergebnis des Triggerereignisses geschieht, legen
Sie alternativ einen Nachtriggerzeitraum fest, der lang genug zurückreicht, um die Daten nach dem Trigger aufzuzeichnen.

Flanke und Pegel
Die Flankensteuerung bestimmt, ob das Gerät den Triggerpunkt auf der ansteigenden oder der abfallenden Flanke des
Signals findet. Die Pegelsteuerung bestimmt, an welcher Stelle dieser Flanke der Triggerpunkt auftritt.

Verzögertes Triggersystem
Sie können mit dem (Haupt-) Triggersystem A allein triggern oder den (Haupt-) Trigger A mit dem (verzögerten) Trigger
B kombinieren, um auf aufeinanderfolgenden Ereignissen zu triggern. Bei der sequentiellen Triggerung aktiviert das
Triggerereignis A das Triggersystem, und das Triggerereignis B triggert das Gerät, wenn die Bedingungen für den Trigger B
erfüllt sind. Die Trigger A und B können separate Quellen aufweisen, dies ist der Normalfall. Die Bedingungen des Triggers
B können auf einer Zeitverzögerung oder auf einer angegebenen Anzahl von Ereignissen basieren. (Siehe Seite 49,
Verwenden von A- (Haupt-) und B- (verzögerten) Triggern.)
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Auswählen eines Triggertyps
Das Gerät ermöglicht Ihnen, die grundlegenden Triggerparameter über die Frontplatte zu ändern oder im Steuerungsfenster
„Trigger Setup” (Triggereinstellung) weitere erweiterte Trigger einzurichten.

HINWEIS. Einige Triggertypoptionen sind auf manchen Geräten nicht verfügbar.

1. Drücken Sie EDGE (FLANKE).

2. Legen Sie die Quelle, Flanke und den
Modus fest. Die Kopplung legen Sie
im Menü Trig (Trigger) > Edge Setup
(Flankeneinstellung) fest.

3. Um einen anderen Triggertyp
auszuwählen, gehen Sie
folgendermaßen vor:

Drücken Sie ADVANCED
(ERWEITERT).

Wählen Sie einen Triggertyp direkt
über das Menü „Trig“ (Trigger) aus.

4. Stellen Sie die Triggereinstellung mit
Hilfe der Steuerelemente fertig, die für
den jeweiligen Triggertyp angezeigt
werden. Die Bedienelemente zum
Einstellen des Triggers sind für die
einzelnen Triggertypen unterschiedlich.
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Auswahl von Pinpoint-Triggern
Trigger-Art Trigger-Bedingungen
Flanke Trigger auf einer ansteigender oder abfallender Flanke, entsprechend der

Definition in der Flankensteuerung. Verfügbare Kopplungsarten sind Gleichstrom,
Wechselstrom, NF-Unterdrückung, HF-Unterdrückung sowie Rauschunterdrückung.

Glitch Triggern auf einem Impuls, der schmaler (oder breiter) als die angegebene Breite
ist, oder Ignorieren solcher Glitches, die schmaler (oder breiter) als die angegebene
Breite sind.

Breite Triggern auf Impulsen, die sich innerhalb oder außerhalb eines bestimmten
Zeitbereichs befinden. Es kann auf positive oder negative Impulse getriggert werden.

Runt Trigger auf einer Impulsamplitude, die eine Schwelle überschreitet, eine zweite
Schwelle jedoch nicht überschreitet, bevor die erste Schwelle erneut überschritten
wird. Es können positive oder negative Runts ermittelt werden oder nur die, deren
Breite eine angegebene Breite überschreitet. Diese Impulse können auch durch den
logischen Zustand anderer Kanäle qualifiziert werden.

Fenster Triggern, wenn das Eingangssignal über einen oberen Schwellenwert ansteigt
oder unter einen unteren Schwellenwert abfällt. Triggern des Geräts, wenn das
Signal in das Schwellenwert-Fenster eintritt oder dieses verlässt. Qualifizieren
das Triggerereignis zeitlich mithilfe der Option „Trigger When Wider” (Triggern bei
größerer Breite) oder nach dem logischen Zustand anderer Kanäle mithilfe der
Option „Trigger When Logic“ (Triggern nach Logik).

Timeout Triggern, wenn innerhalb einer angegebenen Zeit kein Impuls festgestellt wird.

Übergang Sie triggern auf Impulsflanken, die den Bereich zwischen zwei Schwellenwerten mit
hoher oder geringer Geschwindigkeit als der angegebenen Zeit durchqueren. Die
Impulsflanken können positiv oder negativ sein.

Serieller
Anschluss

Triggern auf 64-Bit-Bitmuster bei Datenraten bis zu 1,25 Gb/s (Modelle mit <4 GHz)
und 40-Bit-Bitmuster bei Datenraten bis zu 3,125 Gb/s (nur Modelle mit >4 GHz).
Sperren bei einer Pseudozufallsbitfolge. Option PTM oder PTH erforderlich. Dieser
Modus schließt die Taktrückgewinnung mit ein. Um die Taktrückgewinnung wieder
zu initialisieren, drücken Sie die Taste Auf 50 % setzen.
Die Funktion Pattern Lock (Bitmustersperre) findet und sperrt automatisch eine lange,
wiederholt auftretende Pseudozufallsbitfolge (PRBS, pseudo-random bit sequence).
Diese Sperre bedeutet, dass das Gerät die Bitlänge der Pseudozufallsbitfolge kennt
und vorhersagen kann, wenn sich der Zyklus wiederholt. Die Funktion Pattern
Lock ermöglicht, dass das Gerät an bestimmten Orten in einem Datenmuster mit
hervorragender Zeitbasisgenauigkeit Abtastpunkte erfasst.

Pattern Triggern, wenn durch logische Eingangswerte die ausgewählte Funktion „Wahr“ oder
„Unwahr“ wird. Sie können auch angeben, dass die logischen Bedingungen für
einen bestimmten Zeitraum vor der Triggerung erfüllt werden müssen.

Zustand Triggern, wenn alle logischen Eingaben in die ausgewählte logische Funktion
bewirken, dass die Funktion „Wahr“ oder „Falsch“ wird, wenn die Takteingabe den
Zustand verändert.

Setup/Hold Triggern, wenn eine logische Eingabe den Zustand innerhalb der Setup- und
Hold-Zeit relativ zum Takt ändert. Der Modus triggert auf eine Setup- und
Holdverletzung.
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Trigger-Art Trigger-Bedingungen
Comm Triggern in Verbindung mit den Maskentests auf Kommunikationscodes und

Standards. Die Steuerelemente wirken zusammen, um die Parameter für das
Triggerereignis zu definieren (mit Option MTM oder MTH verfügbar). Dieser Modus
schließt die Taktrückgewinnung mit ein. Um die Taktrückgewinnung wieder zu
initialisieren, drücken Sie die Taste Auf 50 % setzen.

Video Sie triggern auf angegebene Felder oder Zeilen eines Composite-Videosignals. Es
werden nur Composite-Signalformate unterstützt.

SPI Triggern auf SPI-Signalen (Serial Peripheral Interface).

I2C Triggern auf Inter-IC-Control-Signalen (I2C): Start, Stopp, wiederholten Start,
fehlende Bestätigung, Adresse, Daten und Adresse und Daten.

RS‑232 Triggern auf RS-232-Signalen.

CAN Triggern auf CAN-Bussignalen.

Überprüfen des Trigger-Status
Sie können den Triggerstatus anhand der Statusleuchten an der Frontplatte oder anhand der Anzeige überprüfen.
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Überprüfen Sie Steuerelemente ARM
(ARMIERT), READY (BEREIT) und TRIG’D
(GETRIGGERT), um den Triggerstatus zu
ermitteln.

Wenn TRIG’D (GETRIGGERT) leuchtet,
hat das Gerät einen gültigen Trigger
erkannt und füllt den Nachtriggeranteil
des Signals.

Wenn READY (BEREIT) leuchtet,
kann das Gerät einen gültigen
Trigger entgegennehmen und wartet
darauf, dass er eintritt. Es wurden
Vortriggerdaten erfasst.

Wenn ARM (ARMIERT) leuchtet, füllt der
Triggerschaltkreis den Vortriggeranteil
der Signalaufzeichnung.

Wenn TRIG’D (GETRIGGERT) und
READY (BEREIT) leuchten, wurde
ein gültiger Ereignistrigger A erkannt,
und das Gerät wartet auf einen
verzögerten Trigger. Bei Erkennung
eines verzögerten Triggers wird der
Nachtriggeranteil des verzögerten
Signals gefüllt.

Wenn ARM (ARMIERT), READY
(BEREIT) und TRIG’D (GETRIGGERT)
nicht leuchten, wurde die Erfassung
beendet.

Um die Einstellungen einiger
Schlüssel-Triggerparameter schnell
zu bestimmen, überprüfen Sie die
Triggeranzeige unten in der Anzeige.
Die Anzeigen sind für Flanken- und
Komfort-Trigger unterschiedlich:

1. Triggerquelle A = Ch1

2. Triggerflanke = ansteigende Flanke

3. Triggerpegel

4. Zeitbasis
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Verwenden von A- (Haupt-) und B- (verzögerten) Triggern
Verwenden Sie den Ereignistrigger A (Haupt-Trigger) für einfache Signale oder in Kombination mit dem Ereignistrigger B
(verzögerter Trigger), um komplexere Signale zu erfassen. Nachdem das A-Ereignis aufgetreten ist, sucht das Triggersystem
nach dem B-Ereignis, bevor das Signal getriggert und angezeigt wird.

Trigger A

1. Wählen Sie Trig > A Event (Main)
Trigger Setup... (Trigger) > Einstellung
Ereignistrigger A (Haupt-Trigger)...) aus.

2. Legen Sie Art und Quelle für den
A-Trigger auf der Registerkarte „A Event“
(Ereignistrigger A) fest.

B-Trigger (Verzögert)

3. Wählen Sie eine Funktion auf der
Registerkarte "A →B Seq".

4. Legen Sie die Trigger-Verzögerungszeit
oder die Anzahl der B-Ereignisse fest.
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5. Legen Sie die Eigenschaften für den
B-Trigger auf der Registerkarte "B
Event (Delayed)" (Ereignistrigger B
(verzögerter Trigger)) fest.

6. Wählen Sie den Triggermodus Normal
und auf der Registerkarte "Mode"
(Modus) den Befehl Auto Holdoff aus.

Trigger auf B-Ereignis

Trigger A aktiviert das Oszilloskop. Die
Erfassung des Nachtriggers startet mit dem
n-ten B-Ereignis.

B-Trigger nach Verzögerungszeit

Trigger A aktiviert das Oszilloskop.
Die Erfassung des Nachtriggers startet
mit der ersten B-Flanke nach der
Trigger-Verzögerungszeit.
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Triggerung mit Reset

Sie können eine Bedingung bestimmen, bei
deren Vorliegen der Trigger zurückgesetzt
wird, sofern sie vor dem B-Triggereignis
eintritt. Wenn das Reset-Ereignis aufgetreten
ist, wartet das Triggersystem nicht mehr
auf das B-Ereignis, sondern wieder auf das
A-Ereignis.

Schnelltipps
Die B-Trigger-Verzögerungszeit und die horizontale Verzögerungszeit sind voneinander unabhängige Funktionen. Wenn
Sie eine Trigger-Bedingung entweder nur mit dem A-Trigger oder mit dem A- und B-Trigger zusammen aufstellen,
können Sie die horizontale Verzögerung verwenden, um die Erfassung weiter zu verzögern.

Korrigieren der Triggerposition
Bei der Korrektur der Triggerposition werden Abweichungen im Datenpfad und Triggerpfad korrigiert, um den Trigger auf
dem angezeigten Signal genauer platzieren zu können. Bei der Korrektur der Triggerposition kann auch die Mittelwertbildung
genutzt werden, um den Trigger exakter auf Störsignalen zu positionieren. Zum genaueren Platzieren von Flankentriggern
auf der Anzeige führen Sie folgende Schritte aus.

1. Zum genaueren Platzieren des Triggers
auf der Anzeige aktivieren Sie Enhanced
Triggering (Verbesserte Triggerung).
Um den Trigger exakter auf Störsignalen
zu positionieren, aktivieren Sie auch die
Option Optimized for Noisy Signals
(Optimiert für Störsignale).
Die Option Optimized for Noisy Signals
(Optimiert für Störsignale) steht nur zur
Verfügung, wenn die Option Enhanced
Triggering (Verbesserte Triggerung)
ausgewählt ist.
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Senden einer E-Mail beim Auslösen des Triggers
Sie müssen das Versenden von E-Mail bei Ereignissen konfigurieren, ehe Sie den folgenden Vorgang ausführen können.
(Siehe Seite 134, Einrichten von „Über Ereignis per E-Mail benachrichtigen“.)

1. Wählen Sie Trig > A Event (Main)
Trigger Setup... (Trigger > Einstellung
Ereignistrigger A (Haupt-Trigger)) aus.

2. Wählen Sie die Registerkarte Mode
(Modus).

3. Klicken Sie unter "E-mail on Trigger"
(E-Mail bei Trigger) auf On (An), und
klicken Sie dann auf Setup (Einrichten).
(Siehe Seite 134, Einrichten von „Über
Ereignis per E-Mail benachrichtigen“.)
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Horizontale Verzögerung verwenden
Verwenden Sie horizontale Verzögerung,
um ein Signaldetail in einem Bereich zu
erfassen, der ein längeres Zeitintervall vom
Triggerpunkt entfernt ist.

1. Drücken Sie auf DELAY (Verzögerung).

2. Passen Sie die Verzögerungszeit mit
dem Bedienelement für die horizontale
POSITION (Position) an, oder geben
Sie die Verzögerungszeit in das
Steuerungsfenster ein.

3. Mit dem Steuerelement SCALE (Skala)
für die Horizontalskala können Sie die
erforderliche Detailanzeige erzielen.

Schnelltipps
Sie können den MultiView-Zoom und die horizontale Verzögerung gleichzeitig zur Vergrößerung einer verzögerten
Erfassung verwenden.

Aktivieren und deaktivieren Sie die horizontale Verzögerung, um die Signaldetails zweier unterschiedlicher, interessanter
Bereiche schnell miteinander zu vergleichen. Ein Bereich liegt in der Nähe des Triggerpunktes, der andere in der
Mitte der Verzögerungszeit.
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Anzeigen eines Signals
Dieser Abschnitt beschreibt Konzepte und Verfahren zum Anzeigen eines Signals. Ausführliche Informationen finden Sie
in der Online-Hilfe.

Einstellen der Darstellungsart
Zum Einstellen der Darstellungsart wählen
Sie Display > Display Style (Anzeige >
Darstellungsart). Wählen Sie anschließend
eine der folgenden Darstellungsarten:

Hiermit werden Signale
mit Linien zwischen
den aufgezeichneten
Punkten dargestellt.

Anzeige der
aufgezeichneten
Signalpunkte als Punkte
auf dem Bildschirm.

Anzeige der
Ist-Abtastungen.
Interpolierte Punkte
werden nicht angezeigt.
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Einstellen des Nachleuchtens der Anzeige
Klicken Sie auf Display > Display
Persistence (Anzeige > Nachleuchten)
und wählen Sie anschließend die Art des
Nachleuchtens aus.

Wenn Sie "No persistence" (Kein
Nachleuchten) wählen, werden
aufgezeichnete Punkte nur für die
aktuelle Erfassung angezeigt. Jede
neue Signalerfassung ersetzt die zuvor
erfolgte Erfassung auf dem jeweiligen
Kanal.

Bei einer unendlichen Nachleuchtdauer
werden fortlaufend Aufzeichnungspunkte
gesammelt, bis Sie eine Einstellung
für die Erfassungsanzeige ändern.
Hiermit können Sie Punkte anzeigen, die
außerhalb der Hüllkurve der normalen
Erfassung liegen.

Bei variabler Nachleuchtzeit werden
die Aufzeichnungspunkte für ein
bestimmtes Zeitintervall gesammelt.
Jeder Aufzeichnungspunkt klingt einzeln
gemäß des Zeitintervalls ab.

Mit der Option "Reset Persistence"
(Nachleuchten zurücksetzen) wird das
Nachleuchten gelöscht.

1. Wenn Sie die variable Neuleuchtzeit
festlegen möchten, wählen Sie Display
> Display Persistence > Persistence
Controls... (Anzeige > Nachleuchten
der Anzeige > Nachleuchtregler).

2. Klicken Sie auf Variable, Persist
Time (Variable Nachleuchtzeit),
und stellen Sie dann mit den
Mehrfunktions-Drehknöpfen die
Nachleuchtzeit ein.
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Einstellen des Anzeigeformats
Das Instrument kann Signale in zwei verschiedenen Formaten anzeigen. Wählen Sie das Format, das Ihren Anforderungen
am ehesten entspricht.

Wählen Sie Display > Display Format
(Anzeige > Anzeigeformat).

Wählen Sie das Y-T-Format, wenn
Sie den zeitlich variablen Verlauf einer
Signalamplitude darstellen müssen.

Wählen sie das X-Y-Format aus,
Wenn Sie die Amplitude der
Signalaufzeichnungen Punkt für
Punkt vergleichen möchten:
Bei Geräten mit <4 GHz werden die
folgenden Kanäle verglichen: Kanal 1 (X)
und Kanal 2 (Y), Kanal 3 (X) und Kanal
4 (Y), Referenz 1 (X) und Referenz 2 (Y)
oder Referenz 3 (X) und Referenz 4 (Y)
Bei Geräten mit ≥4 GHz werden die
folgenden Kanäle verglichen: Kanal 1 (X)
und Kanal 3 (Y), Kanal 2 (X) und Kanal
4 (Y), Referenz 1 (X) und Referenz 2 (Y)
oder Referenz 3 (X) und Referenz 4 (Y)

Wählen Sie das X-Y-Z-Format aus,
wenn Sie die Spannungspegel der
Signalaufzeichnungen Kanal 1 (X)
und Kanal 2 (Y) Punkt für Punkt wie
im XY-Format vergleichen möchten.
Die angezeigte Signalintensität wird
durch die Signalaufzeichnung Kanal 3
(Z) moduliert. Das XYZ-Format wird
getriggert. Ein Signal mit -5 Skalenteilen
(einschließlich Position und Offset)
auf Kanal 3 bewirkt einen einen
leeren Bildschirm. Ein Signal mit
+5 Skalenteilen bewirkt volle Intensität.

Schnelltipps
X-Y-Format ist insbesondere dann nützlich, wenn Sie Phasenbeziehungen wie beispielsweise in Lissajousfiguren
untersuchen möchten.

Das X-Y-Format ist eine reine Punktdarstellung, obwohl es auch mit Nachleuchten angezeigt werden kann. Die
Vektorsignalanzeige hat keine Auswirkungen, wenn Sie X-Y-Format einsetzen.
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Auswählen der Signalinterpolation
Wählen Sie Display > Waveform
Interpolation (Anzeige > Signalinterpolation)
aus, und wählen Sie danach eine der
folgenden Optionen aus:

Die Sin(x)/x-Interpolation berechnet
Aufzeichnungspunkte mithilfe einer
Kurvenanpassung zwischen den
tatsächlich erfassten Abtastwerten.

Durch lineare Interpolation werden
die Aufzeichnungspunkte zwischen
den tatsächlich erfassten Abtastwerten
mithilfe einer linearen Ausgleichung
berechnet.

Schnelltipps
Bei der Sin(x)/x-Interpolation handelt es sich um den Standardinterpolationsmodus. Für die exakte Darstellung des
Signals sind weniger tatsächliche Abtastpunkte als bei der linearen Interpolation erforderlich.
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Hinzufügen von Bildschirmtext
1. Wählen Sie Display > Screen Text

(Anzeige > Bildschirmtext) aus.

2. Geben Sie bis zu acht unabhängige
Textzeilen ein.

3. Klicken Sie auf Text Off (Aus) oder On
(Ein), um die Textanzeige aus- oder
einzuschalten.

4. Klicken Sie zum Auswählen der Schriftart
oder Farbe des Bildschirmtexts auf Font
(Schriftart) oder Color (Farbe).

5. Klicken Sie auf Properties
(Eigenschaften), um das
Steuerungsfenster „Text Properties“
(Texteigenschaften) zum Positionieren
des Texts auf dem Display zu öffnen.

6. Klicken Sie auf Clear (Löschen), um den
gesamten Text in der ausgewählten Zeile
zu löschen.

Schnelltipps
Sie können auf den Bildschirmtext klicken und ihn ziehen, damit er auf dem Bildschirm neu positioniert wird.
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Einstellen der Rasterform
Zum Einstellen der Rasterform wählen
Sie Display > Display Style (Anzeige >
Rasterform). Wählen Sie anschließend eine
der folgenden Rasterformen:

Für eine schnelle
Schätzung der
Signalparameter.

Für Vollbildmessungen
mit Cursorn und
automatischen Anzeigen,
wenn kein Fadenkreuz
erforderlich ist.
Für schnelle
Schätzungen der
Signale, wobei mehr
Platz für automatische
Anzeigen und andere
Daten gelassen wird.
Verwendung mit
automatischen
Anzeigen und anderem
Bildschirmtext,
wenn keine
Bildschirmfunktionen
erforderlich sind.
Für NTSC-Videosignale.

Für alle Videosignale
außer NTSC.
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Festlegen der Triggerpegelmarkierung
1. Wählen Sie Display > Display Objects...

(Anzeige > Objekte anzeigen) aus.

2. Wählen Sie eine der folgenden Optionen
aus:

Short (Kurz) zeigt einen kurzen Pfeil
auf der Rasterseite an.

Long (Lang) zeigt eine horizontale
Linie quer über das Raster an.

Off (Aus) schaltet den
Triggerpegelmarker aus.

Anzeigen von Datum und Uhrzeit
1. Wählen Sie Display > Display Objects...

(Anzeige > Objekte anzeigen) aus.

2. Schalten Sie die Anzeige von Datum und
Uhrzeit auf dem Raster um. Stellen Sie
das Datum und die Uhrzeit mithilfe des
Menüs Utilities (Dienstprogramme) ein.
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Verwenden der Farbpaletten
Wählen Sie Display > Record View Palette
(Anzeige > Palette „Aufzeichnen Anzeigen“)
oder FastAcq/WfmDB Palette aus, und
wählen Sie dann eines der folgenden
Farbschemata für das Signal und das Raster
aus:

Bei der Option „Normal“ werden
Farbtöne und Helligkeitsgrade für
die beste Gesamtansicht angezeigt.
Die Farbe eines jeden Kanalsignals
entspricht der Farbe des jeweiligen
vertikalen Knopfes auf der Frontplatte.

Bei der Option „Temperature Grading“
(Temperaturabstufung) werden die
Signalbereiche mit der höchsten
Abtastdichte rot schattiert dargestellt.
Die Bereiche mit der niedrigsten
Abtastdichte werden blau schattiert
angezeigt.

Bei der Option „Monochrome Green
„ (Monochrom grün) werden die
Signalbereiche mit der höchsten
Abtastdichte hellgrün schattiert
dargestellt. Die Bereiche mit der
niedrigsten Abtastdichte werden
dunkelgrün schattiert angezeigt. Diese
Anzeige ähnelt stark der Anzeige von
Analog-Oszilloskopen.

Bei der Option „Spectral Grading“
(Spektralabstufung) werden die
Signalbereiche mit der höchsten
Abtastdichte blau schattiert dargestellt.
Die Bereiche mit der niedrigsten
Abtastdichte werden rot schattiert
angezeigt.
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Bei der Option „Monochrome Gray
„ (Monochrom grau) werden die
Signalbereiche mit der höchsten
Abtastdichte hellgrau schattiert
dargestellt. Die Bereiche mit der
niedrigsten Abtastdichte werden
dunkelgrau schattiert angezeigt.

Bei der Option „User“ (Benutzerdefiniert)
wird das Signal in einer
benutzerdefinierten Farbe angezeigt.

Schnelltipps
Wählen Sie eine der Farbabstufungspaletten im Steuerungsfenster Display > Colors (Anzeige > Farben) aus, um
unterschiedliche Abtastdichten in verschiedenen Farben anzuzeigen.

Es gibt zwei Farbpaletten, eine für Record View und eine für FastAcq/WfmDB.

Festlegen der Referenzfarben
Wählen Sie Display > Colors... (Anzeige >
Farben...) aus, und wählen Sie danach eine
der folgenden Optionen aus:

Bei der Option „Default“ (Standard)
wird die Standardsystemfarbe für
Referenzsignale verwendet.

Bei der Option „Inherit“ (Vererben) wird
für das Referenzsignal dieselbe Farbe
wie für das Originalsignal verwendet.
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Festlegen der mathematischen Farben
Wählen Sie Display > Colors... (Anzeige >
Farben...) aus, und wählen Sie danach eine
der folgenden Optionen aus:

Bei der Option „Default“ (Standard)
wird die Standardsystemfarbe für
mathematische Signale verwendet.

Bei der Option „Default“ (Standard) wird
für das mathematische Signal dieselbe
Farbe wie für das Kanalsignal mit der
niedrigsten Nummer verwendet, auf dem
die mathematische Funktion beruht.

Schnelltipps
Die Standardfarbe für mathematische und Referenzsignale ist für jedes Signal anders.

Verwenden von MultiView-Zoom
Mit der MultiView-Zoom-Funktion können Sie ein Signal vertikal, horizontal oder in beiden Dimensionen vergrößern.
Gezoomte Signale können auch abgeglichen und gesperrt werden. Über gezoomte Signale kann automatisch ein Bildlauf
durchgeführt werden. Skalierung und Position beeinflussen nur die Anzeige, nicht aber die tatsächlichen Signaldaten.

1. Drücken Sie MultiView-Zoom, um den
Bildschirm zu teilen und ein Zoomraster
hinzuzufügen.
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2. Drücken Sie die Taste HORIZ
(HORIZONTAL) bzw. VERT
(VERTIKAL), um die Achse
auszuwählen, die im Zoomraster
vergrößert werden soll. Mit den
Mehrfunktions-Drehknöpfen können
Sie Skalierung und Position des
vergrößerten Signals anpassen.
In diesem Beispiel befindet sich das
Hauptraster in der oberen Hälfte des
Rasters und das Zoomraster in der
unteren Hälfte des Rasters.

HINWEIS. Sie können gezoomte Signale
ausblenden oder anzeigen. Hierfür
drücken Sie „Waveforms“ (Signale) Hide
(Ausblenden) und aktivieren dann das
gezoomte Signal, das angezeigt werden soll.

3. Um die Zoomrastergröße anzupassen,
wählen Sie entweder über das Menü
„Vertical „ (Vertikal) oder „Horiz/Acq”
(Horiz/Erfass.) „Zoom Graticule Size”
(Zoomrastergröße) aus.

4. Zum Abschalten des Zooms drücken Sie
die Taste auf der Vorderplatte.

Schnelltipps
Sie können auch mithilfe des Menüs „Zoom Setup“ (Zoom-Einstellung) die Rastergröße des gezoomten Signals ändern.
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Zoomen in mehreren Bereichen
Wenn Sie gleichzeitig mehrere Bereiche einer Aufzeichnung anzeigen und vergleichen möchten, gehen Sie folgendermaßen
vor:

1. Klicken Sie, und ziehen Sie ein Rechteck
um den zu zoomenden Signalbereich.

2. Wählen Sie Zoom 1 On (Zoom 1 Ein)
aus.

3. Klicken Sie, und ziehen Sie ein Rechteck
um einen anderen zu zoomenden
Signalbereich, und wählen Sie dann
Zoom 2 On (Zoom 2 Ein).

4. Um den gezoomten Bereich horizontal
anzupassen, klicken Sie auf die
horizontale Markierung unterhalb des
Zoomfeldes, um den gezoomten Bereich
auszuwählen.

5. Passen Sie mit den
Mehrfunktions-Drehknöpfen die
horizontale Position und den Faktor des
ausgewählten Zoombereichs an.
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6. Um den gezoomten Bereich vertikal
anzupassen, wählen Sie Vertical
> Zoom Setup... (Vertikal >
Zoom-Einstellung) aus, klicken auf
ein vertikales Feld und regeln dann mit
den Mehrfunktions-Drehknöpfen die
vertikale Position und den Faktor ein.

Schnelltipps
Zum Löschen des Zoombereichs klicken Sie im Steuerungsfenster Zoom Setup auf Position Factor Reset (Position
und Faktor zurücksetzen).

Über das Steuerungsfenster „Zoom Setup” können Sie jede einzelne Zoomanzeige ein- und ausschalten.

Drücken Sie den Knopf MultiView-Zoom, um alle Zoomanzeigen ein- und auszuschalten.

Wenn Sie den gezoomten Bereich horizontal neu positionieren möchten, klicken Sie auf die horizontale Markierung
unten im Zoomfeld und ziehen daran.
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Sperren von und Bildläufe über gezoomte Signale
1. Um Sperren und Bildlauf zu verwenden,

wählen Sie über das Menü „Vertical „
(Vertikal) oder „Horiz/Acq” (Horiz/Erf)
Zoom Setup... (Zoom-Einstellung) aus,
und wählen dann die Registerkarte Lock
and Scroll (Sperren und Bildlauf) aus.

2. Um über einen einzelnen gezoomten
Bereich einen Bildlauf durchzuführen,
aktivieren Sie eines der Kontrollkästchen
Zoom 1-4, und klicken dann auf die
Schaltfläche „Auto Scroll” (Automatischer
Bildlauf).

3. Um gleichzeitig über mehrere gezoomte
Bereiche einen Bildlauf durchzuführen,
klicken Sie auf Lock (Sperren), und
aktivieren dann die Kontrollkästchen
Zoom1-4, für die Sie einen Bildlauf
durchführen möchten.
Beim Sperren der gezoomten Bereiche
werden diese in ihrer relativen
horizontalen Position gesperrt. Beim
Ändern der horizontalen Position eines
gesperrten und gezoomten Bereichs
werden alle Bereiche geändert.

Schnelltipps
Wenn mehrere Zoombereiche ausgewählt, aber nicht gesperrt werden, wird über den Zoombereich mit der höchsten
Nummer ein Bildlauf durchgeführt. Die anderen Zoombereiche bleiben ortsfest.
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Signale im Zoomfenster ausblenden
1. Zum Ausblenden oder Anzeigen von

Signalen wählen Sie entweder im
Menü Vertical (Vertikal) oder im Menü
Horiz/Acq (Horiz/Erf) die Option Zoom
Setup... (Zoom-Einstellung) aus,
drücken Controls (Bedienelemente) und
drücken dann „Waveforms“ (Signale)
Hide (Ausblenden).

2. Wählen Sie den Zoombereich mit dem
Signal aus, das Sie anzeigen oder
ausblenden möchten.

3. Heben Sie die Hervorhebung für
den Kanal, das mathematische oder
Referenzsignal aus, den oder das Sie
ausblenden möchten.

Suchen und Markieren von Signalen
Sie können besonders interessante Punkte eines erfassten Signals markieren. Solche Markierungen erleichtern die
Begrenzung der Analyse auf bestimmte Signalbereiche. Bereiche eines Signals können automatisch markiert werden, wenn
sie bestimmte Kriterien erfüllen. Sie können aber auch manuell alle interessanten Punkte markieren. Sie können von
Markierung zu Markierung (von einem interessantem Punkt zum nächsten) springen. Mit der Option für Erweiterte Suche
und Markierung können viele derselben Parameter, die zum Triggern verwendet werden können, automatisch gesucht und
markiert werden. Viele Suchparameter weisen kein Zeitlimit als Trigger auf. Sie können auch über mathematischen und
Referenzsignalen suchen. Sie können alle erfassten Ereignisse eines bestimmten Typs finden.

Suchmarkierungen bieten eine Möglichkeit, Signalbereiche als Referenz zu markieren. Über die Suchkriterien können Sie
Markierungen automatisch setzen. Sie können Bereiche suchen und markieren, die bestimmte Flanken, Impulsbreiten,
Runts, Logikzustände, Anstiegs-/Abfallzeiten, Setup-/Hold-Verletzungen und Bus-Suchtypen aufweisen.
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So setzen und entfernen (löschen) Sie Markierungen manuell

1. Drücken Sie MultiView Zoom. Zoom 1
wird mit Markierungen verwendet.

2. Wählen Sie Analyze > Search
(Analysieren > Suchen) aus.

3. Wechseln Sie mit dem Zoomfeld zu dem
Bereich des Signals, in dem Sie durch
Drehen des Mehrzweckknopfs eine
Suchmarkierung setzen oder entfernen
möchten.
Um zu einer vorhandenen Markierung
zu springen, drücken Sie die Taste Next
(Weiter) oder Prev (Vorher).

4. Drücken Sie Setzen/Löschen.
Wenn sich in der Mitte des Bildschirms
keine Suchmarkierung befindet, wird von
Gerät eine hinzugefügt.
Beim Erstellen einer Markierung wird
der horizontale Zoomfaktor gespeichert.
Wenn Sie sich mit Next (Weiter)
oder Prev (Vorher) zwischen den
Markierungen navigieren, wird der
Zoomfaktor wiederhergestellt.
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5. Um Ihr Signal zu untersuchen, wechseln
Sie von Suchmarke zu Suchmarke.
Mit der Taste Next (Weiter) bzw. Prev
(Vorher) können Sie von einer markierten
Stelle zur nächsten wechseln, ohne
irgendwelche anderen Bedienelemente
verwenden zu müssen.

6. Löschen einer Markierung. Um zu der
zu löschenden Markierung zu springen,
drücken Sie die Taste Next (Weiter)
oder Prev (Vorher). Zum Entfernen der
Markierung in der Mitte drücken Sie Set
Clr (Setzen/Löschen). Dies geht bei
manuell wie auch automatisch erstellten
Markierungen.

So setzen und entfernen (löschen) Sie Suchmarkierungen automatisch

1. Wählen Sie Analyze > Search
(Analysieren > Suchen) aus.

2. Wählen Sie im Menü den gewünschten
Suchtyp aus.
Das Suchmenü ähnelt dem Triggermenü.
Standard ist der Flankentyp. Die anderen
Suchtypen sind optional.
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3. Richten Sie Ihre Suche auf
der Registerkarte „Configure“
(Konfigurieren) ein. Zum Kopieren
der Trigger-Einstellungen oder
Sucheinstellungen drücken Sie „Settings
Copy“ (Einstellungen kopieren).

4. Wählen Sie im Fenster „Copy Settings“
(Einstellungen kopieren) aus, von wo
nach wo die Einstellungen kopiert
werden sollen. Drücken Sie „Copy“
(Kopieren) und dann „Close“ (Schließen).

5. Wenn Sie die aktuellen
Sucheinstellungen ändern möchten,
passen Sie die angezeigten
Bedienelemente an. Die angezeigten
Bedienelemente variieren je nach der
ausgewählten Suche.

6. Wenn die Suche nicht bereits
eingeschaltet ist, drücken Sie Search
(Suchen), um die Suche einzuschalten.
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7. Auf dem Bildschirm werden durch grüne
Dreiecke die Positionen automatischer
Markierungen und durch weiße
Dreicke benutzerdefinierte Positionen
angegeben. Diese werden sowohl
in normalen als auch in gezoomten
Signalansichten angezeigt.

8. Sie können Ihr Signal schnell
untersuchen, indem Sie mit den
Pfeiltasten Next (Weiter) und Prev
(Vorher) von einer Markierung zur
nächsten wechseln. Es sind keine
weiteren Einstellungen erforderlich.

9. Zum Umschalten zwischen der Anzeige
der Anzahl der Suchereignisse oder der
Zeit der Markierungen wählen Sie die
Registerkarte Results (Ergebnisse) aus
und drücken „View“ (Ansicht) Count
(Anzahl).

10. Um alle Markierungen in der Tabelle zu
löschen, drücken Sie „All Marks“ (Alle
Markierungen) Clear (Löschen).

11. Wenn Sie die Tabelle der Markierungen in
eine Datei exportieren möchten, drücken
Sie „All Marks“ (Alle Markierungen)
Export (Exportieren).
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12. Zum Konvertieren einer Markierung
oder aller Markierungen in
Benutzermarkierungen drücken
Sie „Search Marks“ (Suchmarken)
Save (Speichern) oder Save All (Alle
speichern).

13. Wenn Sie die aktuell hervergehobene
Zeile in der Tabelle der Markierungen
entfernen möchten, drücken Sie „Search
Marks“ (Suchmarken) Clear (Löschen).

14. Zum Umschalten zwischen der Anzeige
von markierten Stellen in technischer
Notation bzw. in hochpräziser Form
drücken Sie Digits (Ziffern).

15. Um die Anzeige von
Markierungsdreiecken ein- und
auszuschalten, wählen Sie die
Registerkarte View (Ansicht) aus und
drücken Show Marks (Markierungen
anzeigen).

16. Wenn die Erfassung nach Auffinden
einer Übereinstimmung beendet werden
soll, wählen Sie die Registerkarte
Mode (Modus) aus und aktivieren Stop
Acquisition if event found (Erfassung
anhalten, wenn Ereignis gefunden
wurde).

Schnelltipps.
Die Suche wird nur über erfassten Daten ausgeführt. Richten Sie das Gerät ein, um die Daten zu erfassen, nach
denen Sie suchen.

Legen Sie die Abtastrate so fest, dass das Suchereignis wahrnehmbar ist. Sie können nach Glitches suchen, die breiter
als einige Abtastintervalle sind.

Sie können Triggereinstellungen kopieren, um nach anderen Positionen im erfassten Signal zu suchen, die die
Triggerbedingungen erfüllen. Sie können die Sucheinstellungen in den Trigger kopieren.

Flankensuchmarkierungen werden ohne Zoomfaktoren erstellt. Bei anderen Suchtypen werden Markierungen mit einem
geeigneten Zoomfaktor erstellt.
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Wenn Sie „Bring Zoom to Mark“ (Zoom verschieben in Markierung) Zoom 2 oder Zoom 3 drücken, wird die
entsprechende Zoomansicht mit denselben Zoomparametern wie Zoom 1 angezeigt.

Wenn das Signal oder die Einstellungen gespeichert werden, werden benutzerdefinierte Markierungen mit dem Signal
gespeichert.

Automatische Suchmarkierungen werden beim Speichern des Signals nicht mit dem Signal gespeichert. Sie können sie
jedoch bei Wiederverwendung der Suchfunktion problemlos neu erfassen.

Die Suchkriterien werden in den gespeicherten Einstellungen gespeichert.

Die Suche umfasst die folgenden Suchfunktionen:

Suche Beschreibung
Flanke Suche nach Flanken (aufsteigend oder fallend) mit einem benutzerdefinierten Grenzwert.
Glitch Suche nach Impulsen, die schmaler (oder breiter) als die angegebene Breite sind, oder

Ignorieren solcher Glitches, die schmaler (oder breiter) als die angegebene Breite sind.
Impulsbreite Suche nach positiven oder negativen Impulsbreiten, die >, <, = oder ≠ einer

benutzerdefinierten Impulsbreite sind.
Setup & Hold Suche nach Verletzungen von benutzerdefinierten Setup-und-Hold-Zeiten.
Runt Suche nach positiven oder negativen Impulsen, die einen ersten Amplitudenschwellwert

übersteigen, aber nicht einen zweiten Schwellwert, ehe der erste Amplitudenschwellwert
erneut überschritten wird. Suche nach allen Runt-Impulsen oder nur nach denen mit einer
Dauer >, <, = oder ≠ einer benutzerdefinierten Zeit.

Fenster Suche nach einem Signal, das gerade in das Schwellenwert-Fenster eintritt oder dieses
verlässt. Qualifizieren der Suche zeitlich mithilfe der Option „When Wider” (Bei größerer
Breite) oder nach dem logischen Zustand anderer Kanäle mithilfe der Option „When Logic“
(Nach Logik).

Bitmuster Suche nach einer logischen Struktur (AND, OR, NAND oder NOR) über mehrere Signale
hinweg, wobei jeder Eingang auf Hoch, Niedrig oder Beliebig festgelegt wird. Suche nach
dem Punkt, an dem das Ereignis eintritt oder endet bzw. wenn es >, <, = oder ≠ als
eine benutzerdefinierte Zeit aktiv bleibt. Außerdem müssen Sie einen der Eingänge als
Taktgeber für Synchronsuchen (Status) definieren.

Übergang Suche nach ansteigenden oder abfallenden Flanken mit einer Dauer >, <, = oder ≠ als
eine benutzerdefinierte Zeit.

Timeout Suche nach keinem Impuls in einem angegebenen Zeitraum.
Zustand Suche danach, wann alle logischen Eingaben in die ausgewählte logische Funktion

bewirken, dass die Funktion „Wahr“ oder „Falsch“ wird, wenn die Takteingabe den Zustand
verändert.

DDR Lesen Sucht nach DDR-Lese-Impulsen. Erfordert die Option DDRA.
DDR Schreiben Sucht nach DDR-Schreib-Impulsen. Erfordert die Option DDRA.
DDR Lesen und Schreiben Sucht nach DDR-Lese- und Schreib-Impulsen. Erfordert die Option DDRA.
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So analysieren Sie DDR-Signale:

1. Wählen Sie Analyze > DDR Analysis
(Analysieren > DDR-Analyse) aus. Sie
können den größten Teil des Setups
auch über die Suchmenüs erledigen.

2. Wählen Sie den von Ihnen verwendeten
DDR-Standard aus.

3. Optional können Sie Datenrate und
Bezugspegel auswählen. AUTO: Der
Standard. Berechnet die Datenrate und
die Bezugspegel aus dem angewendeten
Signal.

4. Wählen Sie aus den Listen die Quelle für
das Strobensignal und die Daten aus.
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5. Wählen Sie den Typ des DDR-Signals
aus, das Sie identifizieren möchten.

6. Starten Sie die Suche, indem Sie
Show Read Bursts Apply (Lesebursts
anzeigen Anwenden) drücken.
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7. Auf dem Bildschirm zeigen die grauen
Dreiecke und die Linie am oberen
Rand des Rasters die Position der
automatischen DDR-Marken an. Diese
werden sowohl in normalen als auch in
gezoomten Signalansichten angezeigt.

8. Um das DDR-Signal weiter zu
analysieren, drücken Sie Select
Measurements Next (Messungen
auswählen Weiter), um zu DPOJET zu
wechseln.
Mit dem erweiterten Messungspaket,
DPOJET Jitter and Eye Diagram
Analysis-Tool, können Sie das
DDR-Signal messen.
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9. Wählen Sie eine Messung aus.

10. Wählen Sie Configure > Global
(Konfigurieren > Global) aus, um Zoom
oder Cursor zu qualifizieren oder Gatter
mit ihnen zu erstellen.

11. Wenn Sie mithilfe von Logikelementen
qualifizieren, wählen Sie Configure
(Konfigurieren) aus, und wählen Sie die
Quelle der Logikelemente.

12. Drücken Sie OK.

13. Drücken Sie Single (Einzel) oder
Run (Ausführen), um die Messungen
durchzuführen.
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14. Betrachten Sie die Ergebnisse der
Messungen.

Weitere Informationen zur Verwendung von
DPOJET finden Sie in der zugehörigen
Onlinehilfe.
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Analyse von Signalen
Bei der Signalanalyse werden Sie mithilfe der Gerätefunktionen Cursor, automatische Messungen, Statistik, Histogramme,
Mathematik, Spektralanalyse und erweiterte Pass/Fehler-Tests unterstützt. Dieser Abschnitt beschreibt Konzepte und
Verfahren für die Signalanalyse. Ausführliche Informationen finden Sie in der Online-Hilfe.

Durchführen automatischer Messungen
1. Wählen Sie Measure > Measurement

Setup... (Messung > Messung
einrichten...) aus.

2. Wählen Sie den Kanal, das
mathematische oder Referenzsignal aus,
den oder das Sie messen möchten.

3. Wählen Sie über die Registerkarten
Messungen in fünf verschiedenen
Kategorien aus.
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4. Um alle Messungen zu entfernen,
wählen Sie Clear All (Alle entfernen).

5. Wenn Sie mehrere Messungen entfernen
möchten, klicken und ziehen Sie, um die
Messungen auszuwählen, und klicken
dann auf Clear Selected (Ausgewählte
entfernen).

Sie können auch direkt im Menü
„Measure” (Messung) eine Messung
für das ausgewählte Signal wählen.
(Siehe Seite 82, Auswahloptionen für
automatische Messungen.)

Schnelltipps
Im Rollmodus sind Messungen erst verfügbar, wenn Sie die Erfassung beendet haben.
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Auswahloptionen für automatische Messungen
In der folgenden Tabelle werden die automatischen Messungen nach Kategorie aufgelistet: Amplitude, Zeit, weitere,
Histogramm oder Kommunikation. (Siehe Seite 80, Durchführen automatischer Messungen.)

Amplitudenmessungen
Messung Beschreibung
Amplitude Der niedrige Wert abgezogen vom hohen Wert während des gesamten Signals oder des gesamten

getorten Bereichs.
High Dieser Wert wird als 100 % verwendet, wenn hohe Referenzwerte, mittlere Referenzwerte oder

niedrige Referenzwerte benötigt werden, z. B. bei Abfallzeit- oder Anstiegszeitmessungen. Dies
kann entweder mit der Min/Max- oder der Histogramm-Methode berechnet werden. Bei der
Min/Max-Methode wird der gefundene Maximalwert verwendet. Bei der Histogramm-Methode wird
der am häufigsten oberhalb der Mitte gefundene Wert verwendet. Dieser Wert wird während des
gesamten Signals oder des gesamten getorten Bereichs gemessen.

Low Dieser Wert wird als 0 % verwendet, wenn hohe Referenzwerte, mittlere Referenzwerte oder
niedrige Referenzwerte benötigt werden, z. B. bei Abfallzeit- oder Anstiegszeitmessungen. Dies
kann entweder mit der Min/Max- oder der Histogramm-Methode berechnet werden. Bei der
Min/Max-Methode wird der gefundene Minimalwert verwendet. Bei der Histogramm-Methode wird
der am häufigsten unterhalb der Mitte gefundene Wert verwendet. Dieser Wert wird während des
gesamten Signals oder des gesamten getorten Bereichs gemessen.

Eff Die über das gesamte Signal oder den gesamten getorten Bereich gemessene echte
Effektivwertspannung.

Max Normalerweise der größte positive Spitzenspannungswert. Max wird während des gesamten
Signals oder des gesamten getorten Bereichs gemessen.

Min Normalerweise der größte negative Spitzenspannungswert. Min wird während des gesamten
Signals oder des gesamten getorten Bereichs gemessen.

Pk-Pk Die absolute Differenz zwischen der maximalen und der minimalen Amplitude des gesamten
Signals oder des gesamten getorten Bereichs.

Zyklus-Effektivwert Die über den ersten Zyklus des Signals oder des getorten Bereichs gemessene echte
Effektivwertspannung .

+Overshoot
(positives
Überschwingen)

Dieser Wert wird über ein gesamtes Signal oder einen
gesamten getorten Bereich gemessen und wird angegeben als:
Positives Überschwingen = ((Maximum – Hoch) / Amplitude) x 100 %.

-Overshoot
(negatives
Überschwingen)

Dieser Wert wird über ein gesamtes Signal oder einen
gesamten getorten Bereich gemessen und wird angegeben als:
Negatives Überschwingen = ((Niedrig – Minimum) / Amplitude) x 100 %.
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Amplitudenmessungen (Fortsetzung)

Messung Beschreibung
Mittelwert Der über das gesamte Signal oder den gesamten getorten Bereich gebildete arithmetische

Mittelwert.
Zyklusmittelwert Der über den ersten Zyklus des Signals oder des getorten Bereichs gebildete arithmetische

Mittelwert.

Zeitmessungen
Messung Beschreibung
Anstiegszeit Die für die Vorderflanke des ersten Impulses des Signals oder des getorten Bereichs erforderliche

Zeit, um vom unteren Referenzwert (Standard = 10 %) auf den oberen Referenzwert (Standard =
90 %) des letzten Werts anzusteigen.

Abfallzeit Die für die abfallende Flanke des ersten Impulses des Signals oder des getorten Bereichs
erforderliche Zeit, um vom oberen Referenzwert (Standard = 90 %) auf den unteren Referenzwert
(Standard = 10 %) des letzten Werts abzufallen.

+Pulsbreite Der Abstand (Zeit) zwischen den mittleren Punkten der Referenzamplitude (Standard 50 %) eines
positiven Impulses. Die Messung wird beim ersten Impuls des Signals oder des getorten Bereichs
vorgenommen.

-Pulsbreite Der Abstand (Zeit) zwischen den mittleren Punkten der Referenzamplitude (Standard 50 %) eines
negativen Impulses. Die Messung wird beim ersten Impuls des Signals oder des getorten Bereichs
vorgenommen.

+ Duty Cyc
(positives
Tastverhältnis)

Das Verhältnis der positiven Impulsbreite zur Signalperiode als Prozentzahl ausgedrückt. Das
Tastverhältnis wird im ersten Zyklus des Signals oder des getorten Bereichs gemessen.

- Duty Cyc
(negatives
Tastverhältnis)

Das Verhältnis der negativen Impulsbreite zur Signalperiode als Prozentzahl ausgedrückt. Das
Tastverhältnis wird im ersten Zyklus des Signals oder des getorten Bereichs gemessen.

Periode Die erforderliche Zeit, um den ersten Zyklus eines Signals oder eines getorten Bereichs
abzuschließen. Die Periode ist der Kehrwert der Frequenz und wird in Sekunden gemessen.

Freq. Die Frequenz des ersten Zyklus eines Signals oder eines getorten Bereichs. Die Frequenz ist der
Kehrwert der Periode. Sie wird in Hertz (Hz) gemessen, wobei ein Hz einem Zyklus pro Sekunde
entspricht.

Verzögerung Die Zeit zwischen den mittleren Punkten der Referenzamplitude (Standard 50 %) von zwei
verschiedenen Signalen.

Weitere Messungen
Messung Beschreibung
Fläche Die Fläche über dem gesamten Signal oder dem gesamten getorten Bereich in Volt-Sekunden. Die

Fläche oberhalb von Masse ist positiv und die Fläche unterhalb von Masse ist negativ.
Zyklusfläche Die Fläche während des ersten Zyklus des Signals oder des ersten Zyklus des getorten Bereichs

in Volt-Sekunden. Die Fläche oberhalb des allgemeinen Referenzpunkts ist positiv, während die
Fläche unterhalb des allgemeinen Referenzpunkts negativ ist.
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Weitere Messungen (Fortsetzung)

Messung Beschreibung
Phase Der Zeitraum, in dem ein Signal einem anderen Signal vorausgeht oder nacheilt, angegeben in

Grad, wobei 360° einen Signalzyklus beinhalten.
Burstbreite Die Dauer eines Bursts (eine Reihe von einmaligen Ereignissen). Sie wird über das gesamte Signal

oder den gesamten getorten Bereich gemessen.

Histogramm-Messungen
Messung Beschreibung
Sign. Anz. Zeigt die Anzahl der Signale an, die zu dem Histogramm beigetragen haben.
Hits in Box Zeigt die Anzahl von Punkten in oder auf dem Histogrammfeld an.
Peak Hits Zeigt die Anzahl von Punkten im größten Intervallbereich des Histogramms an.
Median Zeigt den Mittelpunkt des Histogrammfeldes an. Die Hälfte aller erfassten Punkte in oder auf einem

Histogrammfeld sind kleiner als dieser Wert und die andere Hälfte größer als dieser Wert.
Max Zeigt die Spannung des höchsten Intervallbereichs ungleich Null in vertikalen Histogrammen oder

die Zeit des am weitesten rechts befindlichen Intervallbereichs ungleich Null in horizontalen
Histogrammen an.

Min Zeigt die Spannung des niedrigsten Intervallbereichs ungleich Null in vertikalen Histogrammen
oder die Zeit des am weitesten links befindlichen Intervallbereichs ungleich Null in horizontalen
Histogrammen an.

Pk-Pk Zeigt den Spitze-zu-Spitze-Wert des Histogramms an. Vertikale Histogramme zeigen die Spannung
des höchsten Intervallbereichs ungleich Null minus die Spannung des niedrigsten Intervallbereichs
ungleich Null an. Horizontale Histogramme zeigen die Zeit des am weitesten rechts befindlichen
Intervallbereichs ungleich Null minus die Zeit des am weitesten links befindlichen Intervallbereichs
ungleich Null an.

Mittelwert Misst den Mittelwert aller erfassten Punkte innerhalb oder auf dem Histogrammfeld.
Standardabw. Misst die Standardabweichung (Effektivabweichung (RMS)) aller erfassten Punkte in oder auf

dem Histogrammfeld.
Mittelwert ±1
Standardabw.

Misst den Prozentsatz der Punkte im Histogramm, die sich in einer Standardabweichung des
Histogramm-Mittelwerts befinden.

84 Schnellstart-Benutzerhandbuch für die DPO7000-Serie und die DPO/DSA70000-Serie



Analyse von Signalen

Histogramm-Messungen (Fortsetzung)

Messung Beschreibung
Mittelwert ±2 Stan-
dardabweichungen

Misst den Prozentsatz der Punkte im Histogramm, die sich in zwei Standardabweichungen des
Histogramm-Mittelwerts befinden.

Mittelwert ±3 Stan-
dardabweichungen.

Misst den Prozentsatz der Punkte im Histogramm, die sich in drei Standardabweichungen des
Histogramm-Mittelwerts befinden.

Kommunikationsmessungen
Messung Beschreibung
Ext Ratio Das Verhältnis der horizontalen zur vertikalen Augenöffnung. Diese Messung funktioniert nur für

Signaldatenbanken oder für im Signaldatenbankmodus gespeicherte Referenzsignale.
Ext Ratio (%) Das Verhältnis der horizontalen zur vertikalen Augenöffnung, angegeben als Prozentsatz. Diese

Messung funktioniert nur für Signaldatenbanken oder für im Signaldatenbankmodus gespeicherte
Referenzsignale.

Ext Ratio (dB) Das Verhältnis der vertikalen zur horizontalen Augenöffnung, angegeben in Dezibel. Diese
Messung funktioniert nur für Signaldatenbanken oder für im Signaldatenbankmodus gespeicherte
Referenzsignale.

Eye Height Messung der vertikalen Augenöffnung in Volt.
Eye Width Messung der horizontalen Augenöffnung in Sekunden.
Eye Top Der bei Messungen des Löschverhältnisses verwendete Spitzenwert.
Eye Base Der bei Messungen des Löschverhältnisses verwendete Basiswert.
Crossing % Der Augendiagramm-Kreuzpunkt, ausgedrückt als Prozentsatz der vertikalen Augenöffnung.
Jitter P-P Der Spitze-zu-Spitze-Wert für den Flankenjitter in den aktuellen horizontalen Einheiten.
Jitter RMS Der Effektivwert des Flankenjitters in den aktuellen horizontalen Einheiten.
Jitter 6 Sigma Der sechsfache Effektivwert des Flankenjitters in den aktuellen horizontalen Einheiten.
Noise P-P Der Spitze-zu-Spitze-Wert des Rauschens oben oder unten im Signal, wie von Ihnen angegeben.
Noise RMS Der Effektivwert des Rauschens oben oder unten im Signal, wie von Ihnen angegeben.
S/N Ratio Das Verhältnis der Signalamplitude zum Rauschen oben oder unten im Signal, wie von Ihnen

angegeben.
Cyc Distortion Die Spitze-zu-Spitze-Zeitschwankung des ersten Augendiagramm-Kreuzpunktes, gemessen an der

mittleren Referenz als Prozentsatz der Augenperiode.
Q-Factor Das Verhältnis von Größe der Augenöffnung zum Rauschen.

Anpassen einer automatischen Messung
Automatische Messungen können angepasst werden, indem Sie Gating verwenden, Messungsstatistiken verändern oder
die Referenzpegel der Messung anpassen.
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Gating

Verwenden Sie Gating, um die Messungen
auf einen bestimmten Signalbereich zu
beschränken.

1. Wählen Sie Measure > Gating > Gating
... (Messung > Gating > Gating) aus.

2. Die Gates werden auf folgende Weise
positioniert:

Klicken Sie auf Cursor, um den den
getorten Bereich auf den Bereich
zwischen den Cursorn festzulegen.

Klicken Sie auf Zoom (1-4), um den
getorten Bereich auf das Raster von
Zoom(1-4) festzulegen.

Statistik

Die Statistik wird automatisch mit den
Messungen eingeschaltet. Die Statistik
charakterisiert die Stabilität der Messungen.

1. Um die Statistik zu ändern, die angezeigt
wird, wählen Sie Measure > Statistics
(Messung > Statistik), und wählen
dann Mean (Mittelwert) oder All (Alle).
(„All“ enthält Min, Max, Mittelwert,
Standardabweichung und Gesamtheit
(Besetzung).

2. Um die Statistik zu entfernen, wählen
Sie Off (Aus).
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Schnappschuss

Um einen Überblick über alle gültigen
Messungen anzuzeigen, wählen Sie
Measure > Snapshot (Messung >
Schnappschuss).

HINWEIS. Wenn die Einstellungen für
eine Messung nicht gültig sind, werden
die Messergebnisse mit 3 Fragezeichen
angezeigt.

Wählen Sie „General“ (Allgemein)
oder „Comm“ (Komm) aus, um
zwischen einer Momentaufnahme von
allgemeinen Messungen oder von
Kommunikationsmessungen zu entscheiden.
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Messungen kommentieren

1. Zum Kommentieren von Messungen
wählen Sie im Steuerungsfenster
für Messeinstellungen die Option
Annotation (Kommentar) aus. In der
Dropdownliste wählen Sie nun die
Messungen aus, die Sie kommentieren
möchten.

2. Den Umfang der Messungskommen-
tierung wählen Sie mit Measure >
Annotation > Standard oder Detailed
(Messung > Kommentar > Standard oder
Detailliert).
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Referenzpegel

Referenzpegel bestimmen, wie zeitbezogene
Messungen vorgenommen werden.

1. Wählen Sie Measure > Reference
Levels... (Messung > Referenzpegel...).

2. Passen Sie die Bezugspegel für
Messungen von unterschiedlichen
relativen oder absoluten Werten an.

Zur Berechnung der Anstiegs- und
Abfallzeiten werden Hohe und
Niedrige Bezugspegel verwendet.
Der Standardwert für die Hohe
Referenz beträgt 90 % und für die
Niedrige Referenz 10 %.

Die mittlere Referenz wird primär
für Messungen zwischen Flanken,
z. B. Impulsbreiten, verwendet. Der
Standardpegel beträgt 50 %.

Die Mid2–Referenz wird bei
dem zweiten Signal verwendet,
das bei Verzögerungs- oder
Phasenmessungen angegeben wird.
Der Standardpegel beträgt 50 %.

Schnelltipps
Um genaue Rauschwerte zu gewährleisten, müssen Sie den Signaltyp auf "Auge" setzen, wenn Sie ein Augensignal
messen.

Durchführen von Cursor-Messungen
Verwenden Sie Cursor, um Messungen mit erfassten Daten vorzunehmen.
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1. Drücken Sie Cursor.

2. Wählen Sie die Cursor-Quelle aus.

3. Wählen Sie einen der folgenden
Cursortypen aus:

H-Balken messen die Amplitude
(gewöhnlich in Volt oder Ampere).

V-Balken messen horizontale
Parameter (normalerweise die Zeit).

Signal- und Bildschirmcursor messen
gleichzeitig vertikale und horizontale
Parameter. Signalcursor sind
dem Signal zugeordnet, während
Bildschirmcursor potenzialfrei und
nicht dem Signal zugeordnet sind.
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4. Um Messungen zwischen zwei
Signalen vorzunehmen, wählen Sie
Waveform (Signal) und wählen dann die
Signal-Quelle für jeden Cursor aus.

5. Wählen Sie Cursors > Cursor
Position... (Cursor > Cursorposition...)
aus, und regeln Sie anschließend mit
den Mehrfunktions-Drehknöpfen die
Cursorposition ein.

6. Lesen Sie die Ergebnisse der
Cursor-Messungen in der Anzeige ab.

Schnelltipps
Verwenden Sie den gekoppelten Cursormodus, um festzulegen, dass sich die Cursor gemeinsam bewegen. Verwenden
Sie den unabhängigen Cursormodus, wenn die Cursor sich einzeln bewegen sollen.

Wenn Sie das Zoomraster verwenden, können Sie einen Cursor direkt auf einem bestimmten Signalpunkt platzieren, um
präzise Messungen vorzunehmen.

Sie können Cursor auch verschieben, indem Sie darauf klicken und diese an eine neue Position bewegen.

Cursor können auch in die Bildschirmmitte verschoben werden, indem Sie Move Cursors to Center (Cursor in die
Mitte verschieben) drücken.

Sie können durchgehende und gestrichelte Cursor auswählen.

Vertikale Cursor messen die Zeit vom Triggerpunkt bis zum vertikalen Cursor.
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Einrichten eines Histogramms
Sie können entweder ein vertikales (Spannungs-) oder ein horizontales (Zeit-) Diagramm anzeigen. Verwenden Sie
Histogrammmessungen, um statistische Messdaten für einen Signalabschnitt entlang einer Achse zu gewinnen.

1. Klicken Sie auf den Zeiger, und ziehen
Sie ihn über den Signalabschnitt, für den
Sie das Histogramm erstellen möchten.
Machen Sie zum Beispiel das Feld für
ein horizontales Histogramm breiter als
es hoch ist.

2. Wählen Sie im Kontextmenü Histogram
Vertical (Histogramm vertikal) oder
Histogram Horizontal (Histogramm
horizontal) aus.

3. Zeigen Sie das Histogramm oben
(bei horizontalen Histogrammen)
oder am linken Rand (bei vertikalen
Histogrammen) des Rasters an.
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4. Um Anpassungen an der
Histogrammskalierung oder an
der Größe und Position des
Histogrammfeldes vorzunehmen, wählen
Sie Measure > Waveform Histograms
(Messung > Signalhistogramme)
aus, und verwenden dann das
Steuerungsfenster Histogram Setup
(Histogramm-Einstellung).

5. Sie können auch automatische
Messungen an Histogrammdaten
vornehmen. (Siehe Seite 80,
Durchführen automatischer Messungen.)

Schnelltipps
Verwenden Sie vertikale Histogramme für Messungen von Signalrauschen und horizontale Histogramme für Messungen
von Signaljitter.

Aktivieren Sie mittels Klicken und Ziehen das Kontextmenü, um die Histogrammanzeige auszuschalten.
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Verwenden von mathematischen Signalen
Erstellen Sie mathematische Signale zur Unterstützung der Analyse der Kanal- und Referenzsignale. Durch Kombinieren
und Umwandeln der Quellsignale und anderer Daten in mathematische Signale können Sie die Datenanzeige ableiten, die
für Ihre Anwendung erforderlich ist.

Gehen Sie bei vordefinierten mathematischen Gleichungen folgendermaßen vor:

1. Wählen Sie Math > Math Setup...
(Mathematik einrichten) aus.

2. Wählen Sie eine der vordefinierten
mathematischen Gleichungen aus.

Gehen Sie folgendermaßen vor, um einen erweiterten Math-Ausdruck zu erstellen.

1. Wählen Sie Math > Math Setup...
(Mathematik einrichten) aus.
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2. Klicken Sie auf Editor.

3. Erstellen Sie den erweiterten Ausdruck
für das mathematische Signal mithilfe
von Quellen, Operatoren, Konstanten,
Messungen, Variablen und Funktionen.

4. Wenn Sie mit dem von Ihnen definierten
Ausdruck zufrieden sind, klicken Sie auf
Apply (Übernehmen).

5. Um Ihren eigenen Filter hinzuzufügen,
klicken Sie auf die Registerkarte Filter.
Klicken Sie auf Load (Laden).
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6. Doppelklicken Sie auf den Ordner für
die Filter, die Sie verwenden möchten.
Doppelklicken Sie auf den Filter, den Sie
verwenden möchten.

7. Erstellen Sie mithilfe des von
Ihnen ausgewählten Filters den
Math-Ausdruck.

8. Wenn Sie mit dem von Ihnen definierten
Ausdruck zufrieden sind, klicken Sie auf
Apply (Übernehmen).

Schnelltipps
Mathematische Definitionen werden nicht implementiert, wenn sie aus unzulässigen Quellen stammen.

Mathematische Signale können aus Kanal- oder Referenzsignalen, aus mathematischen Quellen oder aus Messungen
erstellt werden.

Für mathematische Signale können auf die gleiche Weise Messungen wie für Kanalsignale vorgenommen werden.

Für mathematische Signale wird die horizontale Skala und Position von den Quellen im Math-Ausdruck abgeleitet. Durch
Anpassen dieser Bedienelemente für die Quellsignale wird auch das mathematische Signal angepasst.

Sie können mathematische Signale mit MultiView-Zoom vergrößern, wobei Sie den Zoombereich mit der Maus
positionieren.

Weitere Informationen zu arbiträren Math-Filtern finden Sie in der Online-Hilfe.
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Verwenden von Spektralanalyse
Gehen Sie bei vordefinierten spektralen Math-Ausdrücken folgendermaßen vor: Weitere Informationen finden Sie in der
Online-Hilfe.

1. Wählen Sie Math > Math Setup...
(Mathematik einrichten) aus.

2. Wählen Sie einen der vordefinierten
spektralen Mathe-Ausdrücke aus.

3. Klicken Sie auf Basic (Einfach).

4. Klicken Sie auf Resolution BW
(Auflösung S/W) oder Frequency Span
(Frenquenzspanne), und stellen Sie die
Spektralanzeige mit dem Tastenfeld oder
den Mehrfunktions-Drehknöpfen ein.

HINWEIS. Die Auflösungsbandbreite und
die Frequenzspanne können nur im Modus
„Manual Horizontal“ (Manuell Horizontal)
eingeregelt werden.

Gehen Sie folgendermaßen vor, um einen fortgeschrittenen spektralen Math-Ausdruck zu erstellen.
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1. Wählen Sie Math > Advanced
Spectral... (Mathematik >
Fortgeschritten spektral) aus.

2. Wählen Sie das Math-Signal, das Sie
definieren möchten.

3. Klicken Sie auf den Typ des spektralen
Signals, das Sie erstellen möchten.
Wenn Sie ein Signal neu definieren
möchten, klicken Sie auf Clear
(Löschen).

4. Wählen Sie das Quellsignal aus.

5. Stellen Sie das spektrale Signal mit den
Steuerelementen im Steuerungsfenster
Spectral Setup (Spektral einrichten) und
den Mehrfunktions-Drehknöpfen ein.

6. Sie können gleichzeitig
Zeitbereichssignale und
Frequenzbereichsignale anzeigen.
Sie können auch Gating einsetzen, um
nur einen Teil des Zeitbereichssignals
für die Spektralanalyse auszuwählen.
(Siehe Seite 86, Gating.)
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Schnelltipps
Die Quellen für spektrale Math-Signale müssen Kanäle oder andere Math-Signale sein.

Das Gerät reagiert bei kleineren Aufzeichnungslängen schneller.

Bei größeren Aufzeichnungslängen wird das Rauschen relativ zum Signal verringert und die Frequenzauflösung erhöht.

Unterschiedliche Fensterfunktionen erzeugen im Spektrum unterschiedliche Filterantwortformen und führen so zu
unterschiedlichen Auflösungsbandbreiten. Weitere Informationen finden Sie in der Online-Hilfe.

Die Auflösungsbandbreite (RBW) steuert direkt die Gatterbreite. Deshalb verschieben sich die Gattermarkierungen für
den Zeitbereich, während Sie die Einstellungen vornehmen.

Sie können im Spektrum den linearen Betrag der realen Daten oder die imaginären Daten anzeigen. Dies ist nützlich,
wenn Sie das Spektrum offline verarbeiten, und es dann zurück in eine zeitliche Kurve transformieren.

Verwenden von Maskentests
Mit Maskentests für serielle Kommunikation (Option MTM oder MTH) können Sie ein Signal mit einer vordefinierten Vorlage
oder Maske vergleichen. Damit das Signal den Test besteht, muss es außerhalb der durch die Maske definierten Segmente
liegen. In der Regel werden solche Masken von Normungsinstituten, beispielsweise dem ANSI, definiert. Gehen Sie
folgendermaßen vor, um einen Maskentest durchzuführen:

1. Wählen Sie Masks > Source... (Masken
> Quelle).

2. Wählen Sie die Signalquelle aus.

Schnellstart-Benutzerhandbuch für die DPO7000-Serie und die DPO/DSA70000-Serie 99



Analyse von Signalen

3. Klicken Sie auf die Registerkarte Masks
(Masken).

4. Wählen Sie den Typ und den Standard
aus.

5. Klicken Sie auf Config (Konfig.), um das
Steuerungsfenster Mask Configuration
(Maskenkonfiguration) zu öffnen, in dem
Sie einstellen können, wie Masken und
Verstöße angezeigt werden und wie
Mask Autoset (Masken-Auto-Setup) und
Autofit konfiguriert sind.

6. Klicken Sie auf Masks (Masken), um
zum Steuerungsfenster Mask Setup
(Masken-Einstellung) zurückzukehren.

7. Klicken Sie auf Lock Mask to Wfm On
(Maske auf Wfm verriegeln AN), um
Änderungen an den horizontalen oder
vertikalen Einstellungen der Maske zu
überwachen.

8. Schalten Sie Hit Count On
(Trefferzählung AN) an oder aus, um
Verstöße während eines Maskentests
hervorzuheben.

100 Schnellstart-Benutzerhandbuch für die DPO7000-Serie und die DPO/DSA70000-Serie



Analyse von Signalen

9. Klicken Sie auf Autoset (Auto-Setup),
um das Signal anhand der Merkmale
des Eingangssignals automatisch an der
Maske auszurichten.

10. Schalten Sie Autofit On (Autofit AN) ein,
damit das Signal nach jeder Erfassung
automatisch neu angeordnet wird, damit
die Anzahl der Treffer so niedrig wie
möglich ist.

11. Klicken Sie auf die Registerkarte
Tolerance (Toleranz), und stellen Sie
dann die Toleranz ein.
Bei Toleranzen von mehr als 0 % ist
der Test schwerer zu bestehen und bei
Werten unter 0 % ist der Test leichter zu
bestehen.
Verwenden Sie 0 %, wenn Sie möchten,
dass die Maske der Spezifikation in
der Norm entspricht. Durch Ändern
des Prozentsatzes können Sie
Grenzwerttests ausführen.

12. Wählen Sie die Registerkarte Pass/Fail
Setup (Pass/Fehler). und stellen Sie
dann die Pass/Fail-Parameter ein. (Im
Erfassungsmodus "Signaldatenbank"
wird die Anzahl der Wfms-Label zu
Samples.)

13. Wählen Sie die Nachrichten, die beim
Pass/Fail-Test gesendet werden sollen.
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14. Wählen Sie die Polarität aus, die Sie
testen möchten.

15. Schalten Sie Pass/Fail Test On
(Pass/Fail-Test AN) an oder aus, um den
Maskentest zu starten.

16. Schalten Sie Repeat On (Wiederholung
AN) an oder aus, um den Maskentest
fortlaufend auszuführen.

17. Wählen Sie eine Benachrichtigung
aus, die erfolgen soll, wenn der Test
abgeschlossen ist.

18. Klicken Sie auf die
Registerkarte Pass/Fail Results
(Pass/Fehler-Ergebnisse), um die
Testergebnisse anzuzeigen.

19. Klicken Sie auf Pass/Fail Test On
(Pass/Fail-Test AN), um den Maskentest
zu starten.

20. Klicken Sie auf Reset (Zurücksetzen),
um die Summen zurückzusetzen und
Verstöße zu löschen.

Schnelltipps
Wenn das Signal nicht innerhalb der Maske liegt, müssen Sie "Autoset" (Auto-Setup) aktivieren, um das Signal innerhalb
der Maske zu zentrieren.

Einsatz der Grenzwertprüfung
Die optionale Grenzwertprüfung ermöglicht den Vergleich eines aktiven Signals mit einem Toleranzmaskensignal. Bauen
Sie Ihr Toleranzmaskensignal aus einem bekannten, guten Signal auf, und vergleich Sie es mit einem aktiven Signal
für Pass/Fail-Tests.
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1. Wählen Sie Masks > Limit Test
Setup... (Masken > Grenzwertprüfung
Einst.) aus.

2. Erstellen Sie eine Toleranzmaske,
indem Sie die Quelle, das Ziel und die
Toleranzen auswählen. Die Toleranzen
werden mit dem Mehrzweckknopf
eingestellt. Toleranzen geben den für
das Signal zulässigen Grenzwertbereich
an, bevor der Grenzwerttest fehlschlägt.

3. Klicken Sie auf Save (Speichern). Sie
können mehrere Toleranzmasken
erstellen und für die spätere
Verwendung speichern.

4. Wählen Sie das Quellsignal für den
Vergleich mit der Toleranzmaske aus.

5. Wählen Sie die Toleranzmaske für
den Vergleich mit dem Quellsignal
aus. (Normalerweise ist dies die
Toleranzmaske, die Sie in Schritt 3
erstellt haben.)
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6. Klicken Sie zum Einrichten der
Fehlerbenachrichtigung auf Failure
Notification (Fehlerbenachrichtigung).

7. Wählen Sie „Failure Notification(s)“
(Fehlerbenachrichtigung(en)) aus,
und klicken Sie dann auf Setup
(Geräteeinstellung), um in das
Steuerungsfenster für Einstellungen
zurückzukehren.

8. Klicken Sie unter „Lock Template to
Waveform“ (Maske mit Sig. koppeln)
auf On (Ein), um die vertikale Skala
oder Position der Toleranzmaske an die
des Quellsignals zu koppeln.

9. Klicken Sie unter „Highlight Hits“
(Treffer hervorheben) auf On (Ein),
um die Punkte, die außerhalb der
Toleranzmaske liegen, in einer anderen
Farbe anzuzeigen.

10. Starten Sie den Grenzwerttest durch
Klicken unter „Limit Test“ auf On (Ein).

11. Klicken Sie auf Reset (Zurücksetzen),
um alle Verletzungen zu löschen und
den Test zurückzusetzen.

Schnelltipps
Zum Erstellen einer Toleranzmaske für Grenzwerttests können Sie aktive oder gespeicherte Signale verwenden.

Im Mittelwerterfassungsmodus wird ein glatteres Toleranzmaskensignal erzeugt.

Im Erfassungsmodus „Envelope“ (Hüllkurve) können Sie Toleranzmasken erstellen, die gelegentliches Überschwingen
zulassen.
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MyScope
Mit MyScope können Sie eigene Steuerungsfenster entwerfen, in denen nur diejenigen Steuerelemente enthalten sind, die
Sie regelmäßig verwenden. Statt zwischen vielen verschiedenen Steuerungsfenstern hin- und herzuschalten, fassen Sie die
von Ihnen benötigten Steuerelemente in einem selbst entwickelten Steuerungsfenster zusammen.

In diesem Abschnitt werden die Verfahren zum Erstellen und Einsetzen von MyScope-Steuerungsfenstern beschrieben.
Ausführliche Informationen finden Sie in der Online-Hilfe.

Erstellen eines neuen MyScope-Steuerungsfensters
1. Wählen Sie MyScope > New

Control Window (MyScope > Neues
Steuerungsfenster).

2. Klicken Sie auf + um eine Kategorie
anzuzeigen. In jeder Kategorie
befinden sich Steuerelemente,
die Sie in Ihr individuelles
MyScope-Steuerungsfenster aufnehmen
können. Die Kategorien entsprechen
den Befehlen der Menüleiste, damit Sie
die von Ihnen regelmäßig verwendeten
Steuerelemente einfacher finden
können.
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3. Klicken Sie auf ein Steuerelement, um
eine Vorschau anzuzeigen.

4. Doppelklicken Sie auf das
Steuerelement, oder klicken Sie auf
das +, um die Liste der Steuerelemente
einzublenden. (Falls kein + vorhanden
ist, kann das Steuerelement nicht mehr
verwendet werden).
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5. Deaktivieren Sie die Kontrollkästchen,
um diejenigen Komponenten
zu entfernen, die nicht zu dem
Steuerelement gehören sollen.

6. Klicken und ziehen Sie
das Steuerelement in das
MyScope-Steuerungsfenster. Wenn
Sie die Maustaste loslassen, wird das
Steuerelement an nächstgelegenen
durch das Raster definierten
Platz abgelegt. Sie können die
Lage des Steuerelements im
MyScope-Steuerungsfenster durch
Klicken und Ziehen verändern.
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7. Klicken Sie auf New Tab (Neue
Registerkarte), um eine Registerkarte
in das MyScope-Steuerungsfenster
einzufügen. Sie können maximal sechs
Registerkarten einfügen.

8. Wenn Sie eine Registerkarte
umbenennen möchten, führen Sie
eine der folgenden Optionen aus:

Klicken Sie auf Rename Tab
(Registerkarte umbenennen).

Doppelklicken Sie auf die
Registerkarte, und geben Sie
dann den neuen Namen ein.

9. Klicken Sie auf User Pref...
(Benutzereinstellungen), um
Benutzereinstellungen zu
bestimmen, die zusammen mit
dem MyScope-Steuerungsfenster
geladen werden sollen.
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10. Wenn Sie Steuerelemente löschen
möchten, führen Sie eine der folgenden
Optionen aus:

Wählen Sie eine Registerkarte,
und klicken Sie dann auf Delete
(Löschen). Die Registerkarte und
alle zugehörigen Steuerelemente
werden gelöscht.

Wählen Sie ein Steuerlement,
und klicken Sie dann auf Delete
(Löschen). Nur dieses eine
Steuerelement wird gelöscht.

11. Klicken Sie auf Save (Speichern), und
geben Sie dann einen Namen für das
MyScope-Steuerungsfenster ein, oder
verwenden Sie den Standardnamen.

Schnelltipps
Wenn Sie ein Steuerelement erneut konfigurieren möchten, klicken und ziehen Sie es zurück in das Vorschaufenster.
Aktivieren oder deaktivieren Sie dann die Kontrollkästchen, um Komponenten aus dem Steuerelemet aufzunehmen
oder zu entfernen.

Wenn Sie die Reihenfolge der Registerkarten ändern möchten, klicken und ziehen Sie die Register an eine andere
Position.

Um ein Steuerelement zu löschen, klicken und ziehen Sie es in die oberen Hälfte des Bildschirms (außerhalb des
MyScope-Steuerungsfensters).

Verwenden von MyScope-Steuerungsfenstern
Wenn Sie ein zuvor definiertes MyScope-Steuerungsfenster öffnen möchten, gehen Sie so vor:
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1. Wählen Sie MyScope > Open
Control Window... (MyScope >
Steuerungsfenster öffnen) oder
eines der fünf zuletzt verwendeten
MyScope-Fenster.

2. Aktivieren Sie das gewünschte
MyScope-Steuerungsfenster, und
klicken Sie dann auf Open (Öffnen).

Wenn Sie das aktive MyScope-Steuerungsfenster anzeigen möchten, gehen Sie so vor:

1. Wählen Sie MyScope > Current...
(MyScope > Aktuell) oder klicken
Sie in der Symbolleiste auf
MyScope (MyScope). (Das aktuelle
MyScope-Steuerungsfenster bleibt
aktiviert, selbst wenn es nicht mehr
angezeigt wird.)

Wenn Sie MyScope-Steuerungsfenster bearbeiten möchten, gehen Sie so vor:
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1. Wählen Sie MyScope > Edit Control
Window (MyScope > Steuerungsfenster
bearbeiten).

2. Aktivieren Sie das Steuerungsfenster,
das Sie bearbeiten möchten, und klicken
Sie dann auf Open (Öffnen).

Schnelltipps
Manche Steuerelemente wirken im MyScope-Steuerungsfenster anders als im Standardsteuerungsfenster. Weitere
Informationen finden Sie in der Online-Hilfe.

Sie können MyScope-Steuerungsfenster (.tcw-Dateien) auch in andere Instrumente der Serie DPO7000 kopieren.
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Speichern und Abrufen von Informationen
Im folgenden Abschnitt werden Verfahren zum Speichern und Abrufen von Bildschirmfotos und Setups, zum Speichern
von Messungen mit der Zwischenablage und zum Drucken mit Ihren Instrument beschrieben. Ausführliche Informationen
finden Sie in der Online-Hilfe.

Bildschirmfotos speichern
1. Wählen Sie File > Save (Datei >

Speichern) oder Save as > Screen
Capture... (Datei > Speichern unter >
Bildschirmfoto) .

2. Klicken Sie auf Options... (Optionen),
wenn Sie die Optionen für Farbpalette,
Ansicht, Bild oder Bildschirmfotoformat
einstellen möchten. Anderenfalls fahren
Sie fort mit Schritt 3.
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3. Wählen Sie den Speicherort für das
Bildschirmfoto.

4. Geben Sie einen Namen für das
Bildschirmfoto ein, oder verwenden Sie
den Standardnamen. Wählen Sie dann
einen Dateityp aus.

5. Klicken Sie auf Save (Speichern).

Schnelltipp
Wenn Sie mehrere Bildschirmfotos schnell speichern möchten, wählen Sie Set Front Panel Print Button to Save
(Druckertaste auf Frontplatte auf Speichern setzen), und klicken Sie dann auf Speichern. Nun können Sie ein
Bildschirmfoto speichern, indem Sie auf der Frontplatte die Taste "Print" (Drucken) drücken.

Signale speichern

1. Wenn Sie Signale speichern möchten,
wählen Sie File > Save (Datei >
Speichern) oder Save as> Waveform...
(Datei > Speichern unter > Signal).
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2. Klicken Sie auf Signal.

3. Klicken Sie auf Options...
(Optionen), wenn Sie die
Optionen für Signaldatenbereich,
FastFrame-Datenbereich, Signaldetail,
Datenziel, Quelle oder Datensortierung
einstellen möchten. Anderenfalls fahren
Sie fort mit Schritt 4.

4. Wählen Sie die Quelle aus.

5. Sie können das Signal entweder
als Referenzsignal im Speicher des
Instruments oder als .wfm-Datei in einem
Windows-Verzeichnis speichern. Wenn
Sie ein Signal als Referenz speichern
möchten, wählen Sie "Ref 1–4". Wenn
Sie es als .wfm-Datei speichern möchten,
müssen Sie den Speicherort für das
Signal auswählen.

6. Beim Speichern als .wfm-Datei geben
Sie einen Dateinamen ein oder Sie
verwenden den Standardnamen.

7. Klicken Sie auf Save (Speichern).

Schnelltipps
Wählen Sie Auto-increment file name (Dateinamen automatisch nummerieren), wenn Sie möchten, dass eine Reihe
ähnlicher Signale gespeichert werden, ohne dass Sie jedesmal den ganzen Namen eingeben müssen.

Wenn Sie mehrere Signale schnell speichern möchten, wählen Sie Set Front Panel Print Button to Save (Druckertaste
auf Frontplatte auf Speichern setzen), und klicken Sie dann auf Speichern. Nun können Sie ein Signal speichern, indem
Sie auf der Frontplatte die Taste "Print" (Drucken) drücken.

114 Schnellstart-Benutzerhandbuch für die DPO7000-Serie und die DPO/DSA70000-Serie



Speichern und Abrufen von Informationen

Signale abrufen
1. Wählen Sie File > Recall... (Datei >

Abrufen).

2. Klicken Sie auf Signal.

3. Wählen Sie den Speicherort des Signals,
das Sie abrufen möchten.

4. Wählen Sie das Signal aus, das Sie
abrufen möchten.

5. Klicken Sie auf Recall (Abrufen).
Sobald Sie auf "Abrufen" klicken,
werden das Referenzsignal und dessen
Steuerungsfenster aktiviert.

6. Verwenden Sie die Steuerelemente,
um das Referenzsignal einzustellen.
Zugriff auf das Referenzsignal erhalten
Sie auch, indem Sie File > Reference
Waveform Controls... (Datei >
Steuerelemente für Referenzsignal)
auswählen.

Schnelltipp
Sie können eine Reihe verschiedener Dateitypen speichern, aber Sie können nur Setup-Dateien (*.set) und Signaldatei
(*.wfm) abrufen.
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Instrumenten-Setups speichern
1. Wählen Sie File > Save (Datei >

Speichern) oder Save as > Setup...
(Datei > Speichern unter > Setup) .

2. Klicken Sie auf Setup.

3. Wählen Sie den Speicherort für das
Setup aus. Sie können das Setup
entweder im Speicher des Instruments
an einem der zehn Speicherorte für
Setups oder als .set-Datei in einem
Windows-Verzeichnis speichern.

4. Geben Sie einen Namens für die
Datei ein oder verwenden Sie den
Standardnamen. Verwenden Sie die
Popup-Tastatur, um den Dateinamen für
ein Setup einzugeben, das im Instrument
gespeichert werden soll.

5. Klicken Sie auf Save (Speichern).

Schnelltipps
Wenn der Touchscreen aktiviert ist können Sie mit der Popup-Tastatur Bezeichnungen für die Setups eingeben, damit
Sie diese leicht unterscheiden können.

Wählen Sie "Auto-increment file name" (Dateinamen automatisch nummerieren), wenn Sie möchten, dass eine Reihe
ähnlicher Dateien gespeichert werden, ohne dass Sie jedesmal den ganzen Dateinamen eingeben müssen.
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Wenn Sie mehrere Setups schnell speichern möchten, wählen Sie Set Front Panel Print Button to Save (Druckertaste
auf Frontplatte auf Speichern setzen), und klicken Sie dann auf Speichern. Nun können Sie ein Setup speichern, indem
Sie auf der Frontplatte die Taste "Print" (Drucken) drücken.

Instrumenten-Setups abrufen.
1. Wählen Sie File > Recall... (Datei >

Abrufen).

2. Klicken Sie auf Setup.

3. Wählen Sie das Setup aus, die Sie
abrufen möchten. Sie können eine
Setup-Datei aus einem der zehn
Speicherorte im Instrument oder aus
einem Windows-Verzeichnis abrufen.

4. Klicken Sie auf Recall (Abrufen).

Schnelltipp
Sie können eine beliebige, auf Festplatte gespeicherte Einstellung abrufen und dann für den schnelleren Zugriff an
einem internen Speicherort für Einstellungen speichern.
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Speichern von Messungen.
1. Wählen Sie File > Save (Datei

> Speichern) oder Save as >
Measurement... (Datei > Speichern
unter > Messung) .

2. Klicken Sie auf Options...
(Optionen), wenn Sie "Displayed
Measurements" (Angezeigte
Messungen) oder "Measurement
Format" (Messungsformat) bestimmen
möchten. Anderenfalls fahren Sie fort
mit Schritt 3.

3. Wählen Sie den Speicherort für die
Messung.

4. Geben Sie einen Namen für die Messung
ein, und wählen Sie dann einen Dateityp
aus.

5. Klicken Sie auf Save (Speichern).
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Kopieren der Ergebnisse in die Zwischenablage
Gehen Sie folgendermaßen vor, um den Inhalt der Ausgabe und das Format von Bildern, Signalen oder Messungen
festzulegen, die in die Microsoft Zwischenablage kopiert werden sollen.

1. Wählen Sie Bearbeiten > Copy Setup...
(Bearbeiten > Setup kopieren).

2. Klicken Sie auf eine der Registerkarten
Images (Bilder), Waveforms (Signale)
oder Measurements (Messungen),
und wählen Sie dann die gewünschten
Optionen.

Um Darstellungen, Signale oder Messungen zu kopieren, gehen Sie folgendermaßen vor:
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1. Wählen Sie das zu kopierende Feld aus.

2. Wählen Sie Edit > Copy (Bearbeiten >
Kopieren), oder drücken Sie STRG + C.

3. Drücken Sie STRG + V, um das
Element in eine Windows-Anwendung
einzufügen.
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Drucken
1. Um eine Hardcopy zu drucken, führen

Sie eine der folgenden Optionen aus:

Drücken Sie DRUCKEN.

Wählen Sie File > Print (Datei >
Drucken) aus. Falls erforderlich
können Sie im Dialogfeld "Page
Setup" (Seiteneinstellung) die
Seitenausrichtung ändern.

Die Dialogfelder für „Print" (Drucken) und
„Page Setup" (Seite einrichten) hängen von
dem von Ihnen verwendeten Drucker ab.

2. Klicken Sie auf Page Setup... (Seite
einrichten).

3. Wählen Sie die Druckparameter.
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Ausführen von Anwendungssoftware
Die Optional Application Software CD enthält kostenlose, zeitlich begrenzte Probeversionen der optionalen
Anwendungssoftware, die Sie auf dem Gerät installieren können. Diese Anwendungen bieten anwendungsspezifische
Messlösungen. Einige Beispiele sind im Folgenden beschrieben. Zusätzliche Pakete können verfügbar sein. Weitere
Informationen erhalten Sie von Ihrem Tektronix-Händler oder auf unserer Website unter www.tektronix.com.

Mit CP2 können Sie die Konformität von Masken und Messwerten für die Kommunikationsstandards ITU-T G.703
und ANSI T1.102 testen.

Verwenden Sie die Software für Konformitätstestlösungen DVI für Tests der Konformität von physischen DVI-Schichten.

Führen Sie mit ET3 Konformitätstests für 10/100/1000 Base-T und Ethernet aus.

Setzen Sie das RTE-Modul FBD zum Testen der FB-DIMM-Konformität bei Modellen mit >4 GHz ein.

Verwenden Sie die HT3-Software für HDMI-Konformitätstests zum Testen der HDMI-Konformität.

Verwenden Sie das IBA-RTE-Modul für InfiniBand bei Modellen mit >4 GHz.

Mit dem Programm zur Messung an Festplattenlaufwerken J2 werden Festplattensignale gemäß den IDEMA-Standards
gemessen.

Die Jitter-Analysesoftware JA3 Advanced oder JE3 Essentials wird zur Charakterisierung der Timing-Leistungsdaten
eingesetzt. Jitter-Analyse über fortlaufende Taktzyklen mit Hilfe der Einzelschuss-Erfassung.

Für das Triggern und die Analyse von CAN/LIN-Protokollen steht die Software für die Bitmusteranalyse LSA zur
Verfügung.

Verwenden Sie die MTH-Kommunikationssoftware für Maskentests zum Testen der Maskenkonformität bei Modellen
mit >4 GHz.

Verwenden Sie die MTM-Kommunikationssoftware für Maskentests zum Testen der Maskenkonformität bei Modellen
mit <4 GHz.

Verwenden Sie die MTU-Kommunikationssoftware für Maskentests zum Testen der Maskenkonformität bei Modellen
mit >4 GHz.

Verwenden Sie RTE-Software zur Echtzeit-Augenmessung zum Ausführen von Serienkonformitätstests und Analysen.
Es gibt Konformitätsmodule für viele serielle Standards.

Verwenden Sie das PCE-RTE-Modul für PCI-Express bei Modellen mit >4 GHz.

Triggern und dekodieren Sie mithilfe der Software zum Triggern von Bitmusterprotokollen PTH 8 B/10 B-Daten auf
High-Speed-Bitmuster- oder Datenprotokollen. Protokolltriggern bis zu 3,125 GS/s mit der Option PTH Die Option
Dekodieren steht bei allen Modellen zur Verfügung.

Triggern und dekodieren Sie mithilfe der Software zum Triggern von Bitmusterprotokollen PTM 8 B/10 B-Daten auf
High-Speed-Bitmuster- oder Datenprotokollen. Die Option Dekodieren steht bei allen Modellen zur Verfügung.

Triggern und dekodieren Sie mithilfe der Software zum Triggern von Bitmusterprotokollen PTU 8 B/10 B-Daten auf
High-Speed-Bitmuster- oder Datenprotokollen. Protokolltriggern bis zu 3,125 GS/s mit der Option PTU Die Option
Dekodieren steht bei allen Modellen zur Verfügung.

Verwenden Sie die Software für Leistungsmessungen PWR, um Leistungsverluste in den Schaltnetzteilen und
magnetischen Bauteilen schnell zu messen und zu analysieren.

Verwenden Sie das Konformitätsmodul für Serial ATA und Serial Attached SCSI SST mit der RTE-Option.
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Charakterisieren Sie mithilfe von USB USB 2.0-Signale, einschließlich Maskentests und parametrischer Tests (nur S/W).

Verwenden Sie die VNM-Software für die CAN/LIN-Protokollanalyse zum Testen von CAN und LIN (CAN-Triggern
nicht enthalten).

Zur Installation der Anwendungssoftware
verfahren Sie wie in der dazugehörigen
Anleitung beschrieben. Um die Software
auszuführen, wählen Sie zuerst Analyze
(Analysieren) und anschließend die
Anwendung aus.
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Anwendungsbeispiele
Dieser Abschnitt beschreibt Möglichkeiten, das Gerät bei allgemeinen Fehlerbehebungsaufgaben einzusetzen und seinen
Einsatzbereich auszudehnen.

Erfassen von intermittierenden Anomalien
Eine der schwierigsten Aufgaben, mit denen Entwurfsingenieure zu tun haben, ist das Herausfinden der Ursachen von
intermittierenden Fehlern. Wenn Sie wissen, nach welchem Typ von Anomalie Sie zu suchen haben, ist es leicht, die
erweiterte Triggerfunktion des Oszilloskops so zu konfigurieren, dass die Anomalie isoliert werden kann. Wenn Sie jedoch
nicht wissen, wonach Sie suchen sollen, kann dies eine außerordentlich mühselige und zeitaufwändige Aufgabe sein,
insbesondere angesichts der niedrigen Signalerfassungsrate bei traditionellen Digitalspeicher-Oszilloskopen.

Digital-Phosphor-Oszilloskope, die mit der DPX-Technologie ausgestattet sind, weisen einen außerordentlich schnellen
Erfassungsmodus auf, der als „FastAcq“ bezeichnet wird, mit dem Sie in Sekunden- oder Minutenschnelle solche Anomalien
finden können. Ein normales Digital-Speicheroszilloskop (DSO) würde Stunden oder Tage benötigen, um dasselbe
Ereignis zu finden.

Gehen Sie folgendermaßen vor, um intermittierende Anomalien zu erfassen.
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1. Schließen Sie den Tastkopf an die Quelle
des Eingangssignals an.

Modelle mit <4 GHz

Modelle mit ≥4 GHz

2. Drücken Sie Auto-Setup.

3. Wählen Sie Display > Display
Persistence > Infinite Persistence
(Anzeige > Nachleuchten der Anzeige
> Unendliche Nachleuchtdauer). In
diesem Beispiel suchen Sie nach einem
Taktsignal. Nachdem Sie das Signal
1 bis 2 Minuten beobachtet haben
und bevor Sie das Problem anderswo
suchen, gehen Sie zu Schritt 4.
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4. Drücken Sie FastAcq
(Schnellerfassung).

5. Suchen Sie Glitches, einmalige oder
andere zufällige Anomalien in dem
Signal. In diesem Beispiel wurde mittels
FastAcq ein positiver Glitch von ≈300 ns
Dauer nach nur wenigen Sekunden
entdeckt.
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6. Um auf dem in Schritt 5 gefunden Glitch
zu triggern, wählen Sie Glitch Setup...
(Glitch-Einstellung...) aus.

7. Wählen Sie die geeignete Polarität aus.

8. Klicken Sie auf Level (Pegel), und legen
Sie dann in Abhängigkeit davon, was Sie
in Schritt 5 gefunden haben, den Pegel
fest.

9. Klicken Sie auf Width (Impulsbreite), und
legen Sie dann in Abhängigkeit davon,
was Sie in Schritt 5 gefunden haben, die
Impulsbreite fest.

10. Klicken Sie auf E-mail on Trigger On
(Senden einer E-Mail beim Auslösen
des Triggers Ein). (Siehe Seite 134,
Einrichten von „Über Ereignis per E-Mail
benachrichtigen“.)

11. Drücken Sie Single (Einzeln), um auf
einem einzelnen Glitch zu triggern.
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Verwendung des Erweiterten Desktops und der OpenChoice-Architektur zum
effizienten Erstellen von Dokumentationen

Ingenieure müssen häufig ihr Laborarbeiten für künftige Nachweise dokumentieren. Nutzen Sie die OpenChoice-Architektur,
um Ihre Arbeit in Echtzeit zu dokumentieren, statt Bildschirmdarstellungen und Signaldaten auf einer CD oder einem
USB-Speichergerät zu speichern und erst später einen Bericht zu erstellen.

Gehen Sie folgendermaßen vor, um das Gerät zum Mittelpunkt des Entwurfs- und Dokumentationsprozesses zu machen.

1. Laden Sie Microsoft Word oder Excel auf
dem Gerät.

2. Schließen Sie einen zweiten Monitor
an. (Siehe Seite 6, Hinzufügen eines
zweiten Monitors.)

3. Öffnen Sie Microsoft Word, und ziehen
Sie anschließend das Word-Fenster auf
den erweiterten Desktop.

4. Klicken Sie auf TekScope, um das
Anwendungsprogramm des Geräts
wiederherzustellen.
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5. Wählen Sie Edit > Select for Copy
> Full Screen (bitmap) (Bearbeiten
> Zum Kopieren auswählen > Ganzer
Bildschirm (Bitmap)) aus.

6. Drücken Sie STRG+C.

7. Klicken Sie im Word-Dokument
auf die Stelle, an der Sie die
Bildschirmdarstellung einfügen möchten,
und drücken Sie danach STRG+V.

Schnelltipps
Mit dem Gerät wird eine Reihe von OpenChoice-Softwaretools geliefert, die dazu bestimmt sind, maximale Effizienz
und Anschlussfähigkeit zur restlichen Entwurfsumgebung zu gewährleisten.
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Triggern auf Bussen
Mit dem Gerät können Sie auf CAN- (optional), I2C- und SPI-Busse triggern. Das Gerät kann die physikalische Schicht (als
analoge Signale) und - bei CAN- und LIN-Triggern - die Informationen auf Protokollebene (als digitale und symbolische
Signale) anzeigen.

HINWEIS. Einige Triggertypen sind bei manchen Geräten nicht verfügbar.

So stellen Sie den Bustrigger ein:

1. Wählen Sie Trig > A Event (Main)
Trigger Setup... (Trigger > Einstellung
Ereignistrigger A (Haupt-Trigger)) aus.

2. Legen Sie Art und Quelle für den
A-Trigger auf der Registerkarte „A Event“
(Ereignistrigger A) fest.

3. Wählen Sie Trigger On (Trigger Ein),
um den gewünschten Trigger für das
Merkmal auszuwählen.

4. Je nach Einstellung von Trigger On
(Trigger Ein) müssen Sie möglicherweise
noch weitere Auswahlen vornehmen.
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Triggern bei Video-Signalen
Das Gerät unterstützt das Triggern auf NTSC-, SECAM-, PAL- und hochauflösende Signale.

So verwenden Sie die Videohalbbilder für die Triggerung:

HINWEIS. Der Video-Triggertyp ist auf manchen Geräten nicht verfügbar.

1. Wählen Sie Trig > A Event (Main)
Trigger Setup... (Trigger > Einstellung
Ereignistrigger A (Haupt-Trigger)...) aus.

2. Legen Sie Art und Quelle für den
A-Trigger auf der Registerkarte „A Event“
(Ereignistrigger A) fest.
Wählen Sie Format > 525/NTSC aus.

3. Wählen Sie Trigger On > Field (Trigger
Ein > Halbbild) aus.
Wählen Sie das Halbbild Odd
(Ungerade), Even (Gerade) oder All
(Alle) aus.

Triggerung auf Zeilen
So überprüfen Sie die Videozeilen im Halbbild:
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1. Wählen Sie Trig (Trigger) > A Event
(Main) Trigger Setup...(Einstellung
Ereignistrigger A (Haupt-Trigger)...)
aus.

2. Legen Sie Art und Quelle für den
A-Trigger auf der Registerkarte „A Event“
(Ereignistrigger A) fest.
Wählen Sie Format > 525/NTSC aus.

3. Wählen Sie Trigger On > All Lines
(Trigger Ein > Alle Zeilen) aus.
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Einrichten von „Über Ereignis per E-Mail benachrichtigen“
1. Wählen Sie Utilities > E-mail on Event

> Setup... (Dienstprogramme > Über
Ereignis per E-Mail benachrichtigen >
Setup).

2. Geben Sie die E-Mail-Adresse(n) des
Empfängers ein. Trennen Sie mehrere
Einträge durch Kommata. Die Länge
einer E-Mail-Adresse ist auf 252 Zeichen
beschränkt.

3. Klicken Sie auf Config (Konfig.), und
geben Sie dann die Adresse des
SMTP-Servers ein. Erkundigen Sie sich
bei Ihrem Netzwerkadministrator nach
der richtigen Adresse.
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4. Wählen Sie die Ereignisse aus, bei
denen eine E-Mail gesendet werden soll.

5. Sollen Attachments mitgesendet werden,
wählen Sie zuerst den Attachment-Typ,
und klicken Sie dann auf Settings
(Einstellungen), um das Format zu
bestimmen.

6. Bestimmen Sie die Höchstzahl der
Nachrichten sowie die maximale
E-Mail-Größe. (Die Höchstzahl der
Nachrichten beträgt 50 und die maximale
E-Mail-Größe ist 2000 MB). Wenn die
Höchstzahl der Nachrichten erreicht ist,
müssen Sie auf Reset (Zurücksetzen)
klicken, wenn beim Ereignis weitere
E-Mails gesendet werden sollen.

7. Um sicherzustellen, dass Sie die
E-Mail-Adressen ordnungsgemäß
eingerichtet haben, senden Sie eine
Testmail. Klicken Sie zu diesem Zweck
auf Send (Senden).

8. Nötigenfalls klicken Sie auf Config
(Konfig.), um das Dialogfeld für die
E-Mail-Konfiguration zu öffnen und die
Konfiguration anzupassen.

Schnelltipps
Wenn Sie Attachments auf der Festplatte Ihres Instruments speichern möchten, setzen Sie die maximale
Nachrichtengröße auf Null. Die Attachments werden dann am Standardspeicherort C:\TekScope\Screen Captures
(Bildschirmfotos), Waveforms (Signale) oder Data (Daten) gespeichert. Das hängt vom Typ des Attachments ab.

Fehler beim Eingeben einer gültigen E-Mail-Adresse eines Empfängers, oder von einer SMTP-Serveradresse werden
Fehlermeldungen angezeigt.
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Korrelieren von Daten zwischen einem Tektronix Oscilloscope und einem
Logikanalysator

Fast jedes Design ist ein Hochgeschwindigkeitsdesign mit schnellen Taktsignalflanken und hohen Datenraten. Bei solchen
Designs müssen Sie die analogen Eigenschaften digitaler Hochgeschwindigkeitssignale in Relation zu den komplexen
digitalen Ereignissen in der Schaltung sehen. iView ist Ihr Fenster zur digitalen und zur analogen Welt. Die Funktionen
von iView integriert die Daten aus Tektronix-Logikanalysatoren nahtlos in Tektronix-Oszilloskope und sorgt automatisch
für deren zeitliche Korrelation. Dadurch wird es möglich, analoge Signale vom Oszilloskop per Mausklick an die Anzeige
des Logikanalysators zu übertragen. Dann können Sie die zeitkorrelierten analogen und digitalen Signale nebeneinander
anzeigen und auf diese Weise Quellen von Glitches und andere Probleme ermitteln.

Mit dem externen iView-Oszilloskopkabel können Sie den Logikanalysator an ein Tektronix-Oszilloskop anschließen und so
die Kommunikation zwischen den Instrumenten ermöglichen. Der Assistent zum Hinzufügen von externen Oszilloskopen
ist über das System-Menü der Anwendung TLA verfügbar und leitet Sie durch den Anschluss des iView-Kabels zwischen
Logikanalysator und Oszilloskop.

Auch steht Ihnen ein Setup-Fenster zur Verfügung, in dem Sie die Oszilloskop-Einstellungen überprüfen, ändern und testen
können. Vor dem Erfassen und Anzeigen eines Signals müssen Sie mit Hilfe des Assistenten zum Hinzufügen von externen
Oszilloskopen zwischen dem Tektronix-Logikanalysator und dem Oszilloskop eine Verbindung herstellen.

1. Wählen Sie im System-Menü des
Logikanalysators Add iView External
Oscilloscope....

2. Wählen Sie Ihr Oszilloskop-Modell aus.

3. Befolgen Sie die Anweisungen auf dem
Bildschirm, und klicken Sie dann auf
Next (Weiter).

4. In der Dokumentation des
Tektronix-Logikanalysators finden
Sie weitere Informationen zur Korrelation
von Daten zwischen einem Oszilloskop
und einem Logikanalysator.
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Leistungsüberprüfung mit Grenzwerttests
Ingenieure, die Produktionstests ausführen, müssen häufig die Leistung von Produkten, die von einer Fertigungslinie
kommen, mit einem bekannten, guten Referenzprodukt vergleichen. Wenn die Signale des Prüflings (DUT, device under
test) innerhalb einer benutzerdefinierten Toleranz des Referenzprodukts liegen, besteht das Gerät den Test. Führen Sie
folgende Schritte aus, um diesen Testtyp mit Ihrem Gerät durchzuführen.

1. Erfassen Sie das betrachtete Signal auf
dem Referenzprodukt.

Modelle mit <4 GHz

2. Wählen Sie Limit Test Setup...
(Grenzwertprüfung Einst.) aus.
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3. Wählen Sie in der Liste „Source“ (Quelle)
den Kanal mit dem bekannten,guten
Referenzsignal aus.

4. Wählen Sie in der Liste „Destination“
(Ziel), den Speicherort aus, an dem Sie
die Vorlage speichern möchten.

5. Geben Sie an, um wie viel der Prüfling
von der Toleranzmaske abweichen darf.
Hierfür geben Sie die vertikalen und
horizontalen Toleranzen ein.

6. Klicken Sie auf Save (Speichern). Sie
haben eine Toleranzmaske erstellt, die
einen Schnappschuss der bekannten,
guten Referenz mit den angegebenen
Toleranzen darstellt. Beachten Sie, dass
die Toleranzmaske automatisch aktiviert
wird, wenn Sie auf „Save“ (Speichern)
geklickt haben.

7. Verschieben Sie den Tastkopf von dem
Referenzprodukt zu dem Prüfling.

Modelle mit ≥4 GHz

8. Wählen Sie den Quellkanal aus, der mit
dem Prüfling verbunden werden soll.

9. Wählen Sie die Toleranzmaske aus, die
Sie in Schritt 4 gespeichert haben.
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10. Klicken Sie zum Einrichten der
Fehlerbenachrichtigung auf Failure
Notification (Fehlerbenachrichtigung).

11. Klicken Sie bei diesem Beispiel unter
„Stop Acq“ (Erfassung anhalten) auf
On (Ein), und klicken Sie danach
auf Setup (Einstellungen), um in das
Steuerungsfenster für die Einstellungen
zurückzukehren.

12. Klicken Sie unter „Lock Template to
Waveform“ (Maske mit Sig. koppeln)
auf On (Ein) und unter „Highlight Hits“
(Treffer hervorheben) auf On (Ein).

13. Starten Sie den Grenzwerttest durch
Klicken unter „Limit Test“ auf On (Ein).

Das Gerät vergleicht jedes erfasste Signal mit der Toleranzmaske, bis ein Signal nicht mit der Toleranzmaske übereinstimmt.
Sobald ein solcher Fehler auftritt, wird die Erfassung angehalten, und die Toleranzverletzungen werden andersfarbig auf
dem Display angezeigt. Im folgenden Beispiel ist oben Kanal 1 dargestellt, und Sie können Kanal 1, die Toleranzmaske
und die Treffer erkennen.
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Reinigung
Gehen Sie beim Reinigen des Geräts folgendermaßen vor. Wenn eine weitere Reinigung erforderlich ist, lassen Sie Ihr
Gerät von qualifizierten Kundendienstmitarbeitern warten.

Reinigung von außen
Säubern Sie die Außenflächen des Gehäuses mit einem trockenen, fusselfreien Tuch oder mit einer weichen Bürste. Wenn
sich nicht aller Schmutz entfernen lässt, verwenden Sie ein Stofftuch oder einen Lappen, das oder der in eine 75 %-ige
Isopropylalkohollösung getaucht wurde. Reinigen Sie mit einem Lappen die Engräume um Bedienelemente und Anschlüsse.
Benutzen Sie keine Schleifmittel zum Reinigen des Gehäuses.

Reinigen Sie den Schalter „On/Standby“ (Ein/Standby) mit einem angefeuchteten Reinigungstuch. Besprühen oder
Befeuchten Sie den Schalter nicht direkt.

VORSICHT. Durch ungeeignete Reinigungsmittel, Reinigungsmethoden oder übermäßige Krafteinwirkung kann das Gerät
beschädigt werden. Verwenden Sie keine chemischen Reinigungsmittel, die die am Oszilloskop befindlichen Plasteteile
angreifen könnten. Verwenden Sie bei der Reinigung der Tasten auf der Frontplatte nur entionisiertes Wasser. Benutzen Sie
als Reinigungsmittel eine 75 %-ige Isopropylalkohollösung, und spülen Sie mit entionisiertem Wasser. Bevor Sie ein anderes
Reinigungsmittel verwenden, lassen Sie sich von Ihrem Tektronix Service Center oder einem Vertreter beraten.

Damit während der äußeren Reinigung keine Feuchtigkeit in das Gerät gelangt, verwenden Sie nur so viel Flüssigkeit, wie es
zum Anfeuchten des Tuchs oder Applikators erforderlich ist.
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R
Rasterform „Fadenkreuz“, 59
Rasterform „Gitter“, 59
Rasterform „Rahmen“, 59
Rasterform „Voll“, 59

Rasterformen, 59
Rechtsklick-Menü, 19
Referenzfarben, 62
Referenzpegel, 89
Reinigung, 141
Reinigung von außen, 141
Remote-Anzeige, 6
Rollmodus, 38
RS-232-Trigger

definiert, 47
Runt-Trigger

definiert, 46

S
Schnappschuss, 87, 88
Schnellerfassung, 34, 125
Segmentierter Speicher, 39
Sequentielle Triggerung, 49
Serielle Maskentests, 99
Serieller Anschluss, 131
Setup/Hold-Trigger

definiert, 46
Sicherheitshinweise, v
Signal

abrufen, 115
benutzerdefinierte

Markierungen, 68
Cursor, 90
Darstellungsart, 54
speichern, 113
suchen und markieren, 68

Signalaufzeichnung
definiert, 28

Signaldatenbank-Erfas-
sungsmodus, 29

Signaleingang, 23
Sin(x)/x-Interpolation, 57
Software

optional, 122
Speichern

Bildschirmfotos, 112
E-Mail-Attachments, 135
einrichten, 116
Messungen, 118
Signale, 113

Spektralanalyse, 97
Spektrale Math-Ausdrücke.

Fortgeschritten, 97
Sperren gezoomter Signale, 67
Spezifikationen

Betrieb, 2
Stromversorgung, 4
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SPI, 131
SPI-Trigger

definiert, 47
Spitzenwerterfassungsmodus, 29
Standardeinstellung, 24
Starten einer Erfassung, 31
Statistik, 86
Statusleuchte ARM (ARMIERT), 48
Statusleuchte READY (BEREIT), 48
Statusleuchte TRIG’D

(GETRIGGERT), 48
Störrauschen, 29
Stromversorgung, 4
Suche, 69, 70
Suchen, 68
Systemsteuerung, 11

T
Taste

Markierung setzen/löschen, 69
Tastkopf

Deskew, 26
Kalibrierung, 26
Kompensation, 26

Timeout-Trigger
definiert, 46

Transition-Trigger
definiert, 46

Trigger
Anzeige, 48
erzwingen, 43
Flanke, 44
Holdoff, 43
Konzepte, 43
Kopplung, 44
Modi, 43
Nachtrigger, 43, 44
Pegel, 44
Serieller Anschluss, 131
Status, 47
Vortrigger, 43, 44

Trigger zum Sperren von
Bitmustern, 46

Triggerarten
definiert, 46

Triggerereignis
definiert, 43

Triggerpegelmarker, 60
Triggerposition, 51

U
Über Ereignis per E-Mail

benachrichtigen
einrichten, 134

Übersicht Bildschirmschnittstelle, 14
Unendliche Nachleuchtdauer, 55

V
V-Balken-Cursor, 90
Variable Nachleuchtzeit, 55
Vektoren

Anzeige der Signale als, 54
Verfahren

Signale durchsuchen
und Markierungen
hinzufügen, 68

Vergrößerte Bandbreite, 34
Vergrößerung der DSP-

Bandbreite, 34
Verstärkte Abtastungen

Anzeige der Signale als, 54
Vertikale Position, 24
Vertikale Position und

Auto-Setup, 25
Verzögerter Trigger, 44, 49
Video

Zeilen, 132
Video-Trigger

definiert, 46, 47
Video-Triggern, 132
Vordefinierte Math-Ausdrücke, 94

Vordefinierte spektrale
Math-Ausdrücke, 97

Vortrigger, 43, 44

W
Weitere Messungen, 83
Weiterführende Dokumentation, x

X
X-T-Anzeigeformat, 56
X-Y-Anzeigeformat, 56
X-Y-Z-Anzeigeformat, 56

Z
Zeitmarken, 40

definiert, 39
Zeitmessungen, 83
Zoom, 63
Zoomrastergröße, 64
Zubehör, 1
Zustandstrigger

definiert, 46
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